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INTRODUCTION

n a textbook, Fred T. Hofstetter of the University of Delaware says "the
I ability to use multimedia will emerge as a life skill in the twenty-first
century. Citizens who do not know how to use multimedia will become
disenfranchised. Cut off from the Information Superhighway, they will end up

watching life go by instead of living it fully." (Multimedia Literacy, McGraw-Hill,

1997)"

Why Attend This Workshop?

To alleviate Information Anxiety about multimedia! “What is information anxiety

—itis the gap between what we understand and what we think we should

understand. Information anxiety is the black hole between data and knowledge. It
happens when information doesn’t tell us what we want or need to Know. (Richard

Saul Wurman, Information Anxiety, Bantam Books, 1990).”

In today’s environment, when every new week brings new software and new file
formats, we all can suffer “information anxiety.” It is hoped that through this

workshop, you will gain insight into how multimedia can be used in your research

and deliverable documents.

Research has shown that people remember nearly 90% of the information from
presentations that use visuals when compared to presentations that are not

visualized. And nothing makes a presentation more memorable than pictures. They

inform, they clarify, they influence ... and they add impact. It is essential for

writers, researchers, and trainers, to turn to new communication methods that play

a key role in communicating ideas.

Definition: “Multimedia is the use of a computer to present and combine text,

graphics, audio and video, with links and tools that let the user navigate, interact,

create and communicate.”

Multimedia can make the learning process more effective. The concept of

conveying information through the combined use of words, images, numbers and
sounds to capture the attention of the five senses (including touch, smell and taste)

is not new. What is new are the advances in technologies which allow the reader
both to receive and interact with multimedia information and sometimes even to

create multimedia information.
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INTRODUCTION

Multimedia means, in a sense, multisensory, which is an effective way of receiving
and imparting information. Each element, text, images and sounds, can reinforce
each other for the purpose of conveying meaning. It helps the learner to understand
ideas and information but it does demand different skills from traditional
information handling.

Out of the five human senses, vision is the most powerful data acquisition for the
brain. Edward Tufte, a professor of statistics and graphic design at Yale University,
finds that the most effective presentation of information is visual rather than verbal
alone. A visual display carries more information at higher speeds to the brain than
simple speech. Plain text or speech requires more effort to follow because less
information is conveyed at a slower speed thus requiring more concentration and
extrapolation on the part of the listener.

A well known example of graphical communication is a map combining historical
and geographic information into one graphic. This charts Napoleon’s trek with his
army to Moscow and their return to France. The gray section is the route to
Moscow, the black is the return trip. The thickness of the line represents the
number of men in the army at each point in the journey. It paints a clear picture of
attrition. Along the bottom is a temperature scale that shows how cold the winter
weather actually was on the grim march home.

i Nupoleorn's 1812 Russizn Cunpaign 9

mipli=aw

Why try to describe something to your audience when you can show it to
them? For example, when someone says "Grand Canyon", you don't think
of those words, you see a majestic, winding gorge.

1-2  Publishing with Multimedia




INTRODUCTION

it’s All About Communication
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We can trace humankind's use of pictorial symbols, or pictographs as they are
often called today, to abstract prehistoric markings inscribed on rocks and the
walls of caves. By 2,000 B.C., the Egyptians had created simplified images that
eventually led to the replacement of symbolic pictures with phonetic writing. Over
the centuries, languages evolved, adding enormous variety to the communication
process.
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First and foremost, a document is a tool to communicate information. The type of
information will affect the type of communications. Ultimately, the content
expressed in the document is what really matters. If the reader understands the
content, your communication was successful.
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In the fourth century B.C., Aristotle observed that a person’s memory of a given
item of knowledge was facilitated by associating that idea with another, either in
contiguity, in sequence, or in contrast. Your document is your tool to facilitate this
acquisition of knowledge on your reader’s part. It is your foremost job! How else
will your audience be able to recognize the value of your work?

Document Organization and Layout

There are fundamental reasons for subdividing any large body of information
delivered on the printed page. Underlying all layout schemes are the limitations of
the human brain in holding and remembering information. Cognitive psychologists
have known for decades that most people can only hold about four to seven
discrete chunks of information in short-term memory. The goal of most layout
schemes is to keep the number of variables the reader must keep in short-term
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INTRODUCTION

memory to a minimum, using combination of graphic design and layout
conventions along with division of information into discrete units.

When your content is mostly text, typography is the tool you use to "paint"
patterns of organization on the page. The first thing your reader sees is not the title
or other details of the page, but the overall pattern and contrast of the page. The
reader’s eye scans the page first as a purely graphic pattern, then begins to track
and decode type and page elements.

The regular, repeating patterns established through carefully organized pages of
text and graphics help the reader to quickly establish the location and organization
of your information, and increase the overall legibility of your pages. Patchy,
heterogeneous typography and text headers makes it difficult for the user to see
major patterns quickly, and makes it almost impossible to for the user to quickly
predict where information is likely to be in located in unfamiliar documents. Once
the layout is defined, you can more easily determine the appropriate placement of
any multimedia elements.

T pasle:loy, i memnxizienl Reller Tayposl ol hype hlmzks

Copyright Lynch & Horton, 1997. Yale University.
http://info.med.yale.edu/caim/manual/
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Steps to Good Design

INTRODUCTION

Most of our current concepts about structuring information stem from the
organization of printed books and periodicals, and the library indexing and catalog
systems that developed around printed information. Gutenberg's bible of 1456 is
often cited as the first modern book, yet even after the explosive growth of
publishing that followed Gutenberg it took more than 100 years for page
numbering, indexes, tables of contents, and even title pages to become routine
features of books. Here are a few good steps to begin with in establishing your
own document design:

ESTABLISH A VISUAL HIERARCHY

Create a strong, consistent visual hierarchy, where important elements are
emphasized, and content is organized logically and predictably. Graphic design is
visual information management using the tools of layout, typography, and
illustration to lead the reader's eye through the page. Readers see pages first as
large masses of shape and color, with foreground elements contrasted against the
background field. Only secondarily do they begin to pick out specific information,
first from graphics if they are present, and only afterward do they start parsing the
"harder" medium of text and begin to read individual words and phrases:

Thus the overall graphic balance and organization of the page is crucial to drawing
the reader into your content. A dull page of solid text will repel the eye as a mass
of undifferentiated gray, but a page dominated by poorly designed or overly bold
graphics or type will also repel sophisticated users looking for substantive content.
‘What you want is an appropriate balance that attracts the eye with visual contrast.

DIRECT THE READER'S EYE

In the West readers of English read from left to right, and from the top of the page
to the bottom. This fundamental visual axis dominates most design decisions, and
is the basis for most conventional graphic design of print publications. In page
layout the top of the page is always the most dominant location.

BE CONSISTENT

Establish a layout grid and a style for handling your text and graphics, then stick
with it to build a consistent thythm and unity across all the pages. Repetition is not
boring; it gives your document a consistent graphic identity. A consistent approach
to layout and navigation allows readers to quickly adapt to your design, and to
confidently predict the location of information across the pages of your document.
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INTRODUCTION

Multimedia Goals and Design Issues

The first step in designing a document with multimedia is to make sure you have
defined a set of goals - know what it is you want to accomplish. Without a clear
statement of purpose and objectives, the project will begin to wander off course
and bog down, or may go on past the point of diminishing returns.

Careful planning and a clear sense of purpose are the keys to success in
incorporating multimedia, particularly if you will be working as part of a team.
Before beginning, you should:

» Identify your target audience - Identify the potential users of your document, so
that you can structure the document to meet their needs and expectations. The
knowledge, background, interests, and needs of users will vary from novices
who need a careful structured introduction, to experts who may chafe at
anything that seems to patronize them or delay their access to information.

» Have a statement of purpose and know your main objectives - A clear, short
statement of objectives should form the foundation of your document design.
This is where you expand on the goals in your statement of purpose, and will be
the tool you will use to analyze the success of your document. All presentations
of information are determined by your objectives, the practicality of the
medium you chose, and the nature of your audience.

You should also begin to identify all of the content information and graphic
resources you will need to collect or create to achieve the goals you have set for
your document.

Whether you’re designing a handout, a slide, or a Web page, the same general
graphic design principles apply. The goal with all design is to reduce the amount of
effort the reader has to invest to decode the message, so that the reader can devote
most of their processing power to understanding the message itself.
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A BIT ABOUT

Bitmaps and Objects

GRAPHICS

visual appeal, demonstrate a process, represent a product, break up long
passages of text thus providing relief to tired eyes, to represent an idea
that is easier to show than to explain, “A picture is worth a thousand words.”

Gmphics can be added to a document for a variety of purposes: to add

In this chapter we will look at some common image types and ways of obtaining
them.

IMAGES

There are two broad categories for representing graphic images — bitmap (raster)
and object-based (vector).

A bitmapped or raster representation is the classic form used by "paint” systems.
Each dot on the display screen corresponds to a bit of information in computer
memory (hence the term bit, mapped). In contrast, object-based vector systems
(sometimes called geometric) are usually referred to as "draw" systems. Vector
graphics use a geometric description to represent objects, such as lines, circles, and
curves. These objects can be meaningfully manipulated as objects, not simply as
dots on the screen. For example, to move a line, you can grab the end point and
drag it to another place on the screen while the line stays intact; this is called
rubber banding. The "paint” and "draw" distinctions originated with the success of
MacPaint and MacDraw on the Macintosh, which use bitmap and vector
representations, respectively.

Each approach has advantages and disadvantages. Using the bitmapped approach,
you cannot select end points of lines or reshape curves. However, you can feather

the edge of a shape into a soft blur or smoothly transition from one pastel shade to
another. Painterly visuals such as soft edges and blurring are not practical when a

system uses an object-based approach. Image manipulations with functions such as
edge detection and contrast enhancement also require a bitmap representation.
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Some graphics systems attempt to combine these two paradigms; however, the
bitmap and vector paradigms are the two fundamental representations of images.

Here's is a simulation of the differences between bitmap and vector graphics. The
left circle demonstrates how a bitmap image is defined by a finite set of pixels.
Enlarge it, and you can really see the pixels. However, up the resolution to lose that
"pixel-y look," and you run into vile file-size issues. The image on the right could
be enlarged 10 times and still look just as sharp — if it were a vector graphic.

Some examples of Raster paint programs are Adobe Photoshop, Paint Shop Pro,
Macromedia X-Res, Fractal Design Painter, and L-View.

Some examples of vector programs are Adobe Illustrator, Corel Draw, and
Macromedia Freehand.

Choosing a Bitmap’s Resolution
When setting the dpi (dots per inch) setting for a bitmap image, keep these tips in
mind.

» For best results when printing, choose a value that divides evenly into the
resolution of your printer. For example, for a 300-dpi printer, choose 75, 100,
150 or 300.

* For best results when viewing on screen, import at multiples of your screen
resolution, for example 72 dpi or 144 dpi.

The larger the dpi, the smaller the graphic.

75 dpi
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SCREEN CAPTURES AND RECORDING

g3 sNRNRERETEREOEEN RN NN NN UERNRENRORERBRRRRRR RN
Screen Capture programs let you snap a picture of a window or your entire screen
and save it in different image formats. This can be helpful for a variety of reasons,
to prove you made that high score in a game, show someone a problem with a
program, or just to show what a program looks like.

Screen Captures in Windows 95

Microsoft Camcorder

Windows 95 has a built-in screen capture function that can be used to copy the
active window or the entire screen contents. The image is held on the clipboard
until you paste it into a document or application.

To copy an image of the window that is currently active, press ALT+PRINT
SCREEN.

To copy an image of the entire screen, press PRINT SCREEN.

TIP
To paste the image into a document, click the Edit menu in the document window,
and then click Paste.

If you need to edit the screen capture, you can paste it into the Microsoft Paint
program that comes with Windows 95 or other graphics editing program that you
may have loaded on your system.

If you installed Office from a CD-ROM, you can install and use Microsoft
Camcorder to record actions, procedures, and sounds that you perform on your
computer. You can save the recording as a movie that you can then play in
Camcorder, or you can save the movie as a stand-alone program that you can send
to others to play, even if they don't have Camcorder. For example, you can use
Camcorder to create a computer tutorial that you can send to others to use. You can
set preferences for movies that you record, such as the keys to use to stop
recording a movie, the quality of the sound you record, and whether to show
Camcorder in front of open programs.

Although you cannot run Camcorder on Microsoft Windows NT Workstation, you
can play a movie that has been recorded in Camcorder as a stand-alone program.

For information about how to use Microsoft Camcorder, see Microsoft Camcorder
Help.
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NOTE

If you have not already installed Microsoft Camcorder, insert the Microsoft Office
CD-ROM in your CD-ROM drive, and then run Microsoft Camcorder Setup. To do
this, double-click the ValuPack folder on the CD-ROM, double-click the MSCam
folder, and then double-click Camcordr.exe. To start Microsoft Camcorder, click
the Windows Start button, point to Programs, and then click Microsoft Camcorder.

Screen Captures/Recording with the shareware program Snaglt/32!

Lotus ScreenCam

SnaglIt/32 by Techsmith is an excellent Capture utility that features a catalog
browser for managing its image, text, and video captures. Captures are sent
directly to the printer, the clipboard, or an e-mail message, saved in one of many
file formats, or sent to the new catalog browser to review and process later.
Includes new advanced options including a preview window, anti-alias scaling,
color substitution, cropping, text editing, and automatic configuration of video
parameters. Also incorporates annotation, append to file, and column delimiting
features available for text captures, and DDE, batch conversion, multiple output,
and autonaming features available for all captures.

A 45 day evaluation copy of Snaglt/32 can be downloaded from it’s parent site:

http://www.techsmith.com. To cost to purchase a license is $39.95.

A product called SnapShot can be downloaded from:
http://www.geocities.com/CapitolHill/2171/

Snaglt/32, SnapShot and many other Capture utilities can be downloaded from:
http://www.tucows.com

Lotus ScreenCam turns your PC into a VCR that records every click, scroll and
action on your screen.

You can add captions and the sound of your voice. Then edit your instant PC
movies and share them over the Internet or by e-mail with customers, colleagues

~ and employees. Viewers can play them back even if they don't have ScreenCam on

their computers.

Use up to twenty movie segments to demonstrate new products, explain complex
financials, troubleshoot software problems, train new employees, share
applications expertise, create custom tutorials and more.

1. The screen captures in this document were created using Snaglt/32.
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Download a 15 day trial version from the Lotus web site http:/www.lotus.com.
Cost is around $89.95 for single user license off the shelf.

Screen Recording Software for Solaris Environments
HighSoft Xrecorder(TM) is a stand-alone program which allows you to make
recordings (called "xrecordings") of your software in an X Window System
environment, You can then play back your xrecording without the presence of your
software application during playback. In addition, HighSoft Xrecorder allows you
to annotate your xrecording with visual information such as text, graphic images,
pointers, and box highlights, as well as with audio such as voice-over and music.
HighSoft Xrecorder requires absolutely no changes to your application software to
allow capture, annotation, and playback.

Xrecorder can be used to create: Self Running Demos, Training Tutorials, WWW-
based Software Product Demonstrations, Embedded Multimedia inside Digital
Books. A demo version can be downloaded from the HighSoft web site at
http://www.highsoft.com. (Click on Dog & Pony Show at bottom of web page.)
Also check out the new product Dog & Pony Show for Windows environments.

ANIMATED GIFS

How to make GIF animation:
From Global Presence at
http://animationcreations.com/animated/gifs_index4.htm

It's easy to make GIF animation. Just three simple steps:

1 You will need a way to make the individual images which will become the
frames of the animation. Any paint or draw program will do. You can find
many shareware paint and draw programs by searching through the
shareware archives; for example, you could try shareware.com
(www.shareware.com).

2 Make the frames showing the successive instances of the animation.

You can also animate a pre-existing image. You can find a variety of available
images on the web, for example browse through the sites listed in Yahoo’s Icon
Section at http://www.yahoo.com/ or try the Browser at Pisa at
http://sunsite.unc.edu/gio/iconbrowser/icons/mirrors.html
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3 Once you have the frames ready you will need a program that can stack them
into a GIF animation. Freeware or shareware programs which will do this are
available for the following platforms:

* Windows - a program called GIF Construction Set
http://www.mindworkshop.com/alchemy/gifcon.html

GIF Construction Set is shareware. It costs $20.00 (US) to register, plus $5.00
shipping. Please see the Alchemy Mindworks Home Page at the above URL, for
complete information.

* Macintosh - a program called GifBuilder
http://iawww.epfl.ch/Staff/Y ves.Piguet/clip2gif-home/GifBuilder.html

¢ Unix - a program called GIFMerge
http://the-labs.com/gifmerge.htm]l

If you can upload your frames to a server, then you do not need any of these
programs. There is a site called the Imaging Machine at
http://www.vrl.com/Imaging/index.html which will stack them into a GIF
animation for you over the web. You can find more information about GIF
animation from Royal Frazier's All about GIF §9a at
http://members.aol.com/royalef/gifabout.htm.

® An excellent site with comparisons of 6 different animated gif programs with
additional links to utility programs is the The Mining Company at
http://desktoppub.miningco.com/library/weekly/blfil

® A page with links to a large number of animated gif web sites can be found at
http://animationcreations.com/animated/gifs_index4.htm

® A large variety of animated gifs can be found at The Clip Art Connection at
http://www.clipartconnection.com/mainframe.php3?page=gifofday.php3&gda
te=081298
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Definitions can be found in the Glossary.

Extension Definition

bmp Bitmap

.cgm Computer Graphics Metafile

.ps Encapsulated PostScript

.gif Graphics Interchange Format

.png Portable Network Graphic

rgb Red, Green, Blue

Aif Tagged Image File Format

.vrm Virtual Reality Modeling Language
.wmf Windows Metafile Format

INTERESTING FACTOIDS
* Texton a PC is usually larger than text on a Macintosh.

* Colors generally appear darker on a PC than on a Macintosh.
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Sampling Audio

Downloadable Audio

Streaming Audio

about five minutes long. For the song to have the quality comparable to

a CD (16-bit, 44KHz), it would need at least 10 megabytes of space.
Audio samples of less than 30 seconds, which translates to just under a megabyte,
at 8-bit, mono, and 11KHz or 22KHz, are a more reasonable size to work with in
your documents.

! udio files can be very large. Your favorite song, for example, is probably

DIGITAL AUDIO

Digital audio is measured using a method called sampling. While digitizing there
are three aspects to this measurement and conversion: bit depth, which is the depth
at which the audio is sampled. (This is similar to the bit depth of graphics where 24
bits looks better than 8 bits.) KHz, which is the frequency of sampling. (Kilohertz
is thousands per second); and channels (mono, one channel or stereo, and two
channels).

The three more common audio file formats are: .wav (standard PC format), .aiff
(standard CD and Macintosh format), and .au (standard UNIX format). Most
browsers can be configured to play all of these formats, with the addition of a
helper application.

Streaming audio and video are new technologies that offer the playing of files
while they are downloading. Streaming audio offered over the internet requires a
reduction of bandwidth, and translates into lower quality sound.

Streaming technologies include Real Audio(www.realaudio.com), NetShow
(http://www.netshow.net/), and Interactive Music Architecture (IMA). These types
of technologies are improving rapidly, but they still have limitations currently, such
as a lack of accepted standards means that not everyone is readily equipped to
access your files, limited bandwidth means lower quality, and in some cases, limits
the number of simultaneous users.
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As with any kind of digital signal, the phrase, "Garbage in, garbage out," is
specially true when digitizing audio. Always try to use the original source of audio,
and therefore the highest quality—whether it comes from a CD, a tape, or just a
microphone recording your voice.

Configure Your Audio Equipment

Start Digitizing

Begin by connecting your audio source to your computer. You can either use a
built-in microphone port on your computer, or in some cases you may need an
audio digitizing board. Most consumer audio devices offer an audio-out port. A
headphones port will work just as well for your connection. Connect the audio
source to your computer using a standard audio cable. Depending on the
connections on both ends, you may need to find an adapter at your local electronics
store.

Test the connection by recording a short sample. With this test, you can make sure
your connection is clear; it also gives you a chance to adjust the incoming signal
volume. If you’re using a Macintosh, you may need to increase the incoming
volume within the Sound control panel, as well as on your source audio equipment.

Select Record in your sound editing software. While digitizing, make sure the
volume is at the correct level. This is indicated by the volume status bar. Most
audio software packages have this kind of feature. The bar shows the volume level
of the incoming sound and generally reads left to right—the higher the volume, the
higher the sound. Some applications color-code these levels; and, similar to a piece
of home audio equipment as long as the bar stays green, the level is in the correct
range. If, however, it dips into red on the high end, you should turn down the
volume of your incoming source.

After you’ve digitized the sample, look at file using the Waveform view, accessible
from the View menu. If the Waveform appears chopped off at the top or bottom, try
redigitizing at a lower volume.

Special Effects and Downsampling

After you’ve digitized, you will have plenty of options for affecting the sound
depending upon which software program you are using to edit your sound. If the
volume of the clip is too low, you should be able to Amplify it. Make sure the
Waveform doesn’t clip at the top or bottom, in which case, you should Undo the
command and try a lower percentage. Any clipping in the Waveform translates into
a lower quality sound, usually with static.
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‘When you’ve got your sound just right, it’s time to downsample and output. If
you’ve digitized anything other than an 8-bit, mono, 11 KHz file, you’ll need to
reformat it. Keep in mind that, given the current limitations of the internet, this is
your optimum format. Set your Format options and save the file. The most
common format for both the PC and Unix platforms is .wav files, and there are
shareware applications for Macintosh that allow the playback of these files.

SoundApp is a Macintosh utility that easily converts .aiff files into .wav files.

SoundApp homepage: http://www-cs-students.stanford.edu/~franke/Sound App/

Multiple audio files can be easily mixed to create a complex background sound.
Open one audio file in your sound editing program and then layer or add tracks to
accommodate all the sounds you want to use. When you play them back, they will
be mixed automatically. You can then adjust their combined sound by moving the
tracks individually to the right or left. Once you have all of your sounds in the right
places, you mix the tracks together with a Mix command.

Looping an audio file can be an efficient way to add musical interest without using
too much bandwidth. Audio files can be looped a couple of ways, depending on
how they will be accessed.

The HTML tag <bgsound> allows incorporation of a loop with the HTML page.

If you incorporate your audio file into a ShockWave animation, you can loop the
file in its entirety using Macromedia’s Director’s scripting language, called Lingo.

SoundEdit 16 for Macintosh. This program is the most popular of the midrange
audio file creation and modification programs. It is capable of creating and
modifying CD quality sound or better. Some of the effects do take quite a while to
be processed, but for the most part the user interface is very easy to master. There
have been several improvements made in this new version of SoundEdit 16 since
the release of the first SoundEdit Pro in the early 90s, including more efficient disk
usage, an improved user interface, and less crashes. SoundEdit is currently in
version 2.0 and the system requirements are a 68020-PowerPC with a minimum of
6megs RAM.

Here is a SoundEdit 16 link:
http://www.tamu.edu/cis/sell/soundedit.html
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Saving an Audio Clip from the Web

1

3

Cznientg o

STOP

When you play a sound file (.wav, .au, .midi), a “player” window similar to the
one In the figure below opens.

To save the sound file, RIGHT MOUSE CLICK on the sound player box and
select SAVE AS from the pull-down options menu.

ight mouse click on the
sound player box and select
Save As from the options
menu.

s e [ e e

Jillisueawsdl)iilty \

PLAY PAUSE

About...

An alternate way to retrieve a file, if for instance, you are unable to save a file you
listened to or had already exited the program but had not yet deleted your cache,
try the following:

In Windows 95, open Windows Explorer.

Navigate to the directory where the Netscape or Microsoft Internet Explorer
cache files are stored.

The default pathway to the Netscape cache file is usually something like this:
C:\Program Files\Netscape\users\yournameécache -

The default cache file for Microsoft Internet Explorer is usually found in the
following directory:
C:\Windows\Tempory Internet Files

Click on the TYPE button to sort files by type.

ZAFroger Fileshk ataca:e\Usera\Iaaf’ﬁa:be'

Name
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4 Scroll down to the file type you are looking for (.midi, .wav, etc.).
Mvs99pBk.gif 8KB GIF Image 8/17/98 3:50 AM
MvuOithi.gif BKB  GIF Image 8/17/98 951 AM
4KB MIDI Sequence 817798 353 AM
gpc MOntmd73.htm 1KB Netscape Hypertext... 8/17/98950 AM
B M13kmvio. htm 1KB Netscape Hypertest... 8/17/98'9:50 AM
Double-click on a file to hear it played. The names may not be easily recognizable
(except for the extension part), so you may have to play a few to tind the one you want.
If you are in the Windows 95 environment, a different player is used than the one you
saw in your internet browser. It may be similar to one of the ones below:
Microsoft Midi Sequence player, plays midi music files Microsoft Sound Recorder, plays wave files
(comes with Windows 95) (comes with Windows 95)

Fl M1nbljyls.mid

@ asknot.wav - Sound Becorder HEE

File Edit Effects Help

Positiot: _ Length:

0.5sec [ IIIEEGEG 35

|
n = -
= 5
PAUSE/PLAY STOP
toggle switch
backward to fast
forward or replay.
5

File Types

Slide / aaesmes s rmennroe o

Drag forward or - l 30 | I f ﬁxl |
{ L— oo
|

|
Rewind  Fast Forward Play Stop

Once you have found the file you want, copy or move it out of the cache file
and save it in the directory of your choice (with a new name if you like, but be
sure to keep the same extension or the file will no longer be recognized).

NOTE:
All of the files in the cache folder will be deleted when you clear the cache from
within your browser.

If you would like to know what file types are registered in your Windows 95

environment (it will differ somewhat from machine to machine depending on what
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programs or add-ons have been loaded), what extensions apply and what program
file will launch them, do the following:

1 OpenWindows Explorer.

2 Select FOLDER OPTIONS from the VIEW Menu.

3 Selectthe FILE TYPES tab.

4 Scroll through the list of Registered file types, highlighting the ones you want
information for. (You can also highlight a file in the list and use the down and
up arrow keys.)

e EE I W
view To7pet F{VaveSoud _
8] Windows E xplorer Command | %
Nsgiteedfisloed:
W Ll S, oren ;l HeaTy 4 I File type details
'P]h‘ rulip

Kioar: I ﬁ Extension: WAY

Jd LT PR TY oy |
b3 Zronciesror Than 20

= 13207 App <3k E | Contert Tppe (MIME} audio/wav
o b2 JUS Bl -1 )
AKasa ol 4 Opens with SNDREC32

PN L
I“ Haacaze spete-:Desurst

=

A Wave Sound has the extension .wav and opens with

Fh o2 b od: Microsoft's Sound Recorder (32bit) program (SNDREC32).
| Cotevior me R o
Lenen: lype i M= cudcrrd [* For this Midi Sequence file type, on this particular machine,
two different extensions are possible, .RM and .MID. A file
g! fNpa - sit RIS 13 that has one of these ext‘ensions will‘ be ‘opened with
e RUNDLL32. RUNDLL32 is a Dynamic Link Library (DLL)

file. A DLL file is a modular program routine that comes
with or can be added to your operating system. DLL files
are dynamically linked with the program that uses them

l F | a4 during program execution. RUNDLL32 launches a Win95
program called Midi Sequence Player.
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AUDIO RESOURCES

MPEG audio files are much smaller than .wav or .au files, yet retain most of the
original sound quality.

MPEG, Macintosh from Kauai Media
http://www.kauai.com/kauai/

XingSound MPEG Audio Player.
Download from: http://www.scsn.net/users/skean/mp2dLhtml

MAPLAY
A simple public-domain audio player for Windows 95 and NT.
http://www.dws.org/sousa/mp2audio.htm

ActiveMovie Control that comes with Microsoft Internet Explorer had MPEG
audio support built in.
http://www.microsoft.com/directx/pavilion/amovie/default.asp

For the Unix platform
maplay_tar.z
http://www.dws.org/sousa/mp2audio.htm

MIDI stands for Musical Instrument Digital Interface. MIDI is a protocol designed
for recording and playing back music on digital synthesizers that is supported by
many makes of personal computer sound cards. Originally intended to control one
keyboard from another, it was quickly adopted for the personal computer. Rather
than representing musical sound directly, it transmits information about how music
is produced. The command set includes note-ons, note-offs, key velocity, pitch
bend and other methods of controlling a synthesizer. The sound waves produced
are those already stored in a wavetable in the receiving instrument or sound card.

Since a MIDI file only represents player information, it is far more concise than
formats that record the sound directly. An advantage is very small file size. A
disadvantage is the lack of specific sound control.

‘With a program that provides this interface, you can create music using a standard
keyboard or other input device. You or others can then play your MIDI-conforming
creation with the same or another program and a sound card as a music synthesizer.
The MIDI program may come with a graphical user interface that looks like a

Publishing with Multimedia 3-7




A BIT ABOUT SOUND
Audio Resources

sound studio control room. Many sound cards come as a package with MIDI
software (for example, Media Vision's Pro Audio Studio 16).

SELECTED LINKS

Standard MIDI Files on the Nets is a comprehensive guide to where to find MIDI
files you can play.

http://www.aitech.ac.jp/~ckelly/SMF.html

In Sweden, Dan Jannson maintains an excellent MIDI Glossary.
http://www.quicknet.se/midimusic/fmg.htm

A great link to MIDI Players, MIDI Plug-ins, & Karaoke Players can be found at:
http://www.aitech.ac.jp/~ckelly/midi/help/midi-players.html

Another site with extensive information and links for midi is the MIDI-Fest web
site located at:
http://sunsite.cnlab-switch.ch/www/mirror/MIDI-Fest/
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just as it does for digitizing audio. Start from the highest quality source. If

you use a professional video camera or player, you’ll get the best quality
input. However, currently most consumer level video cameras offer Hi-8 format
and S-video output. These levels of quality are better than the older 8mm and VHS
standards, and are sufficient for Web video.

T he old adage, "Garbage in, garbage out," holds true for digitizing video

DIGITIZING VIDEO

Configuring Equipment
Connect your video camera or player to your video digitizing board, or directly
into the computer (if your model supports video input). Almost all video digitizing
boards support video cables with RCA connections. RCA cables are the standard
cables used between a television set and VCR. An RCA cable transfers composite
video, which is all the video information combined into one signal. One level of
quality higher than the composite format is S-video. The S-video format consists of
separate signals which can create a better quality video image. If your digitizing
board and camera/player support S-video, use an S-video cable to make the
connection and maintain better quality.

TIP
If you have a video source that supports S-video, and can’t find an S-video cable, a
regular Mac keyboard cable works in a pinch.

Digitizing Settings

Test your video connection by previewing your video footage. In Adobe Premiere,
for example, choose Movie Capture under the File menu. This displays the Movie
Capture window, which shows you a preview from your video source—digitizing
starts only when you hit the Record button. Before you start digitizing, make sure
the digitizing settings are properly set. When digitizing video, you want to over-
sample, or capture more information than you’re going to use to maintain the best
quality.
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The Preview
window in Adobe
Premiere

Choose Recording Settings in the Movie Capture menu. If your final movie will
have a pixel resolution of 160 x120, set the digitizing option to 320 x 240. Click in
the checkbox next to Report dropped frames; this helps you digitize the best
quality video. Most video sources display extra lines of video at the bottom of the
screen. This is due to a video process called overscan, which crops the edges and
limits the size of the video signal on your television set. In the process of digitizing
video, you may see extra pieces of video on the edges of the footage. Crop these
out later.

Now choose Video Input from the Movie Capture menu. Here, you select video
options specific to your system configuration. Choose Source from the pop-up
menu at the top. In the Source window, select your digitizer, input, and format. If
you are able to see a preview of the video in the Movie Capture window, you have
set these settings correctly. Switch to the Image window using the pop-up menu.
Adjust the hue, saturation, brightness, contrast, sharpness, black level and white
level for the incoming signal, depending on the options supported by your
hardware.

The last group of settings is specific to compression and frame rate. Choose
Compression using the pop-up menu. Select the compressor suggested by your
hardware’s manufacturer, and then choose the desired frame rate of digitizing. If
your system is fast enough, you can capture a full 30 frames per second, which
also will generate a final movie file of the best quality. If, however, your system
cannot handle 30 frames per second, set the rate to 15 frames per second.

Now that Premiere is configured for your session, start digitizing. Close the Video
Input window by hitting OK, and click Record in the Movie Capture window.
Digitize a couple of extra seconds at the beginning and the end of your selected
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clip (you will edit these out later). Click again to stop the digitizing process. At this
point, Premiere may display a window notifying you of dropped frames. If this is
the case, change the desired frames per second from 15 to 10, and digitize again.
After you have successfully digitized your selection, save the clip to your hard
drive and play it back for content and quality.

TIP
If your video looks choppy, and it looks like you’re dropping frames, make sure
you have plenty of hard drive space, and optimize and defragment your hard drive.

Editing Video and Adding Transitions
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Import all of your
elements.

The most creative part of working with digital video can be editing and adding
transitions. After you have all of your video and audio clips digitized, and you’ve
created all the still graphics you will need to make your movie, it is time to edit
your images into the final movie.

You start by Importing all of your elements. They will be your "cast of characters,”
including video, stills, mattes, and audio. Keep all of your elements organized in
one folder to save time.

Next, you sequence your elements. Place your video and audio clips and stills into
video and audio tracks in a construction window, usually by taking the imported
images from a project window and dragging them into the construction window.
By placing all of your elements into the Construction window, you’ll have a rough
cut of your movie, and a general idea of the movie’s length. Then you can preview
the movement, and start focusing on the timing of the clips. This gives you a good
idea of what needs to be adjusted or cropped.

Publishing with Multimedia 4-3




A LOOK AT VIDEO
Digitizing Video

A Conztruction Window
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Video and Audio clips are laid out on a series of tracks, like layers, over a time continuum running from left
to right. .

Output
‘When you have finished editing you movie, it is time to output your movie. Your
output and compression options can greatly affect both image quality and file size.
the key to these options is a good balance for your particular clip. For example, the
best quality for some video clips may be a high frame rate. Others may require
fewer frames, but a higher image quality and a larger frame size. In general, the
standard 160 x 120 pixels, 15 frames per second, highest quality setting creates a
good quality movie at a reasonable size. However, be prepared to try several
options to finalize your output settings for the best quality.

Compression Settings
The standard, most reliable and best qulaity compressor is called Radius Cinepak.
in Adobe Premiere, the Compression Settings window allows you to choose
Radius Cinepak in 24-bit color, and also offers a slider bar for quality of the image.
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You should do your own tests regarding different levels of image quality, and how
that impacts the size of the final movie.
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Compression Settings dialog box in Premiere.

Flatten Your Movie
‘When choosing the command Make Movie in Premiere on the Macintosh, you

create a movie that plays on a Macintosh. To ensure cross-platform playback from
the Internet, flatten your movie.

Streaming Video
Streaming video, like streaming audio is part of the new technology that offer the
playing of files while they download. Offering video over the Internet requires the
reduction of bandwidth by limiting pixel resolution, as well as reducing detail and
color.

Streaming technologies include RealAudio, NetShow and Interactive music
Architecture (IMA). Currently these types of technologies have limitations, even
though they are improving rapidly. The current lack of accepted standards means
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that not everyone is readily equipped to access your files, limited bandwidth means
lower quality, and in some instances, limits the number of simultaneous users.

VIEWING VIDEO FILES

Windows 95 Media Player
You can use Media Player to play audio, video, or animation files, and to control
the settings for multimedia hardware devices. Media Player is installed
automatically with Windows 95 and requires a sound card to hear audio.

ﬂﬁtalll

E Prrosme | I8 Accscorie:
= Adode

<
'-] Domume=nci
.= Arhowe nrka

w . :
q‘b sirclhng .= L'cgt Pony Show

.= Intzinc: Esplone

-7 Fax 3
-z Intemet Tools k
= Huliredia
. System Tools
Calculator

—1 HyperT eminal

&) ActiveMovie Control
<9 CD Player
fr Media Player
¢ Sound Recorder
#| Valume Contral

.= Microsof: N=’erence

.22 betseap=z Cumnur ivelu '
- heanaAnits rus EI Imaging

@ Notepad

Using Media Player to view an AVI file

1 To start Media Player, From the Windows 95 START menu, select
PROGRAMS>ACCESSORIES>MULTIMEDIA>MEDIA PLAYER.

2 On the DEVICE menu, click the device you want.
*» Video for Windows plays .avi files
* ActiveMovie plays MPEG movie files.
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3 Double-click the file you want to play.
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A display screen will open on your monitor. Notice that the controls on the
Media Player panel have changed

% K enlog.avi - Media Player (paused) [_T x|
File Edit Device Scale Help

rf — lv]
000 0:30 1:00 130 200 2:30 300 330 400 4:36
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a Click *|to play the multimedia file.
Click !l | to pause the multimedia file.

Click | B to stop the multimedia file.
TIPS
To play a portion of a multimedia file, click =] at the starting point, click |2] to

end the selection, and then click Play.
Windows includes some sample multimedia files in the Media folder.

Viewing an MPEG movie
Using the ActiveMovie program that comes with Windows 95.
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1 From you Start menu, select
PROGRAMS>ACCESSORIES>MULTIMEDIA>ACTIVEMOVIE CONTROL.

2 From the OPEN File dialog box, select and double-click the file you would like
to view.

D 1al.mpg

HOW TO CAPTURE SCREEN TO AVI FILES

Microsoft Camcorder
If you installed Office from a CD-ROM, you can install and use Microsoft

Camcorder to record actions, procedures, and sounds that you perform on your
computer. You can save the recording as a movie that you can then play in
Camcorder, or you can save the movie as a stand-alone program that you can send
to others to play, even if they don't have Camcorder. For example, you can use
Camcorder to create a computer tutorial that you can send to others to use. You can
set preferences for movies that you record, such as the keys to use to stop
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recording a movie, the quality of the sound you record, and whether to show
Camcorder in front of open programs.

Camcorder can save screen captures as AVI files or an .EXE file.

http://www.microsoft.com/msoffice/office97/camcorder/default.htm

Screen Captures/Recording with the shareware program Snagltl321

Snaglt/32 by Techsmith is an excellent Capture utility that features a catalog
browser for managing its image, text, and video captures as AVI files. Captures are
sent directly to the printer, the clipboard, or an e-mail message, saved in one of
many file formats, or sent to the new catalog browser to review and process later.
Includes new advanced options including a preview window, anti-alias scaling,
color substitution, cropping, text editing, and automatic configuration of video
parameters. Also incorporates annotation, append to file, and column delimiting

. features available for text captures, and DDE, batch conversion, multiple output,
and autonaming features available for all captures.

A 45 day evaluation copy of SnagIt/32 can be downloaded from it’s parent site:

http://www.techsmith.com. The cost to purchase a license is $39.95.

1. The screen captures in this document were created using Snaglt/32.
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Help
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Screen shot (using Snaglt/32) from an AVl movie, Screen shot (using Snaglt/32), saved as bitmap

saved as a bitmap file.

image, of the same movie in MPEG format. The size

The size of the AVI format movie file was 63,412Kb.  of the MPEG format movie file was 63,341Kb.
Size of bitmap screenshot was 109Kb. Size of bitmap screenshot was 125Kb.

Video Capture Cards

On Intel based PC's, use a video capture card to convert analog video from video
tapes or video cameras to AVI files. A PC video capture card is typically either a
16 bit ISA bus card or a 32-bit PCI bus card that plugs into the 16 bit ISA or 32-bit
PClI slots in your PC motherboard. 32-bit PCI bus cards are steadily replacing 16-
bit ISA bus cards. Most video capture cards have either a composite video
connector or both a composite video and an S-Video connector. Most video
capture cards perform compression of the video in hardware or firmware on the
video capture card before transferring the compressed video over the ISA or PCI
bus to the PC hard drive.

Most video capture cards only capture video. They do not contain audio capture.
Audio capture is done through the audio or sound card of the computer. It is
increasingly common to have the audio input and output hardware built into the
motherboard. The computer may not have a physically distinct sound card.
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Sound cards usually have a Microphone input jack, a Speaker or Headphone output
jack, a Line input jack, and a Line output jack. Line input and the microphone
input are not interchangeable. The jacks use different electrical signals. Most
users will use the microphone for input and speakers or headphone for output.

Authoring Tools to Create AVI Files

A wide variety of 2D and 3D animation applications as well as other multimedia
authoring tools generate AVI files directly. This is especially true for Windows
versions of applications, since Microsoft provides an API for creating AVI files. A
list of applications that can create AVI files follows.

ADOBE PREMIERE

The Adobe Premiere™ program brings the world of digital moviemaking to the
desktop. Adobe Premiere works with Microsoft® Video and QuickTime® for
Windows software, and it lets you record, create, and play movies with video,
sound, animations, photographs, drawings, text, and other material by using your
PC or Macintosh. See Appendix D for GSA pricing on this product.

Microsoft Video and QuickTime for Windows are system utilities that let you
integrate audio and video in Windows applications. You can play Adobe Premiere
movies in any application that supports the Microsoft Video or QuickTime for
Windows format, or you cab output movies to videotape.

http://www.adobe.com
LIGHTWAVE 3D 5.5 FOR WINDOWS 95 AND WINDOWS NT
LightWave is a popular 3D modeling and animation program widely used in

broadcast television. LightWave can do almost anything and supports third party
plug-ins to add features that it lacks.

http://www.lightwave3d.com/

NEWTEK
http://www.newtek.com/

CALIGARI TRUESPACE 1,2, AND 3 FOR WINDOWS

Caligari TrueSpace is a popular low-end 3D modeling and animation program.
Traditionally, TrueSpace has been polygon based limiring its usefulness for
modeling organic forms. TrueSpace 3.0 adds some organic features.

http://www.caligari.com/
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FRACTAL DESIGN RAY DREAM STUDIO FOR WINDOWS
Ray Dream Studio is a suite of 3D modeling, animation, and rendering tools.

http://www.fractal.com/

MACROMEDIA DIRECTOR 6.0 FOR WINDOWS

Macromedia Director is a widely used authoring tool for creating interactive 2D
animations such as presentations, multimedia for kiosks, prototypes of user
interfaces, and similar uses. Director can also produce straight 2D animations
appropriate for AVI files.

http://www.macromedia.com/

CORELMOVE
Corel's CorelMOVE animation software can export AVI files.

http://www.corel.com

MPEG is a powerful lossy compression algorithm. Realtime playback requires a
powerful processor or a dedicated hardware add-on. The MPEG standard specifies
three increasingly sophisticated compression methods. Many MPEG players
support only level 1. Also, many players support only video playback, and not
playback of any accompanying MPEG audio track.

SPARKLE

Sparkle for Macintosh by Maynard Handley <maynard @elwing.otago.ac.nz>,
plays MPEG and QuickTime movies and can convert movies from one format to
the other. Freeware.

ftp:/ftp.its.queensu.ca/pub/macintosh/Internet_Helpers/Sparkle245_folder.sit.hqx
Another great site for downloading Macintosh software can be found at:
http://ccsmacinfo.ccs.queensu.ca/MacSDistribution/Mac_soft.html

POWERPC MPEG PLAYER

Extremely fast, but requires a PowerPC.

ftp://uiarchive.cso.uiuc.edu//pub/systems/mac/info-mac/gst/mov/mpeg-players-
ppc.hgx
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XANIM
For Unix.

http://www.portal.com/~podlipec/home.html

MPEG PLAYER :

Macintosh or Windows. By the MPEG Software Simulation Group.
http://www.mpeg.org/MSSG/

MPEGWIN AND MPEG FOR WIN32

For Windows.
ftp://mirror.aol.com/mir01/CICA/pub/pc/win3/desktop/mpegwin.zip
ftp://mirror.aol.com/mir01/CICA/pub/pc/win3/desktop/mpegw32g.zip
XING MPEG

For Windows.

ftp://mirror.aol.com/mir01/CICA/pub/pc/win3/desktop/mpegv11d.zip

QUICKTIME VIDEO

Apple's QuickTime video technology is popular on multiple platforms. The speed

of playback of QuickTime movies depends on both the speed of your processor
and the compression method used in each individual movie.

http://www.apple.com

MOVIE PLAYER

Apple's standard movie player. Now allows you to flatten movies for playback on

machines other than the Macintosh.

http://www.apple.com
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BRINGING MULTIMEDIA INTO MS WORD 97

insert pictures and scanned photographs — called imported art or

W ord comes with its own set of pictures in the élip Gallery. You can also
graphics — from other programs and locations.

To insert a sound file into a Word document, you can use Sound Recorder — a
Microsoft Windows accessory that lets you record, edit, and play sound files.

You can also insert a video file into a Word document by using Media Player, a
Microsoft Windows accessory that lets you play audio, video, or animation files.

INSERTING A PICTURE IN MS WORD 97
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You can insert clip art or a picture from the Clip Gallery, or you can insert a picture
or a scanned photo you import from other programs and locations.

Insert Clip Art or a Picture from the Clip Gallery
1 Position the insertion point where you want to insert clip art or a picture.

2 On the INSERT menu, point to PICTURE, click CLIP ART, and then click the
CLIP ART or PICTURES tab.

3 Click the category you want, and then double-click the image.

Insert a Picture from Another File
1 Position the insertion point where you want to insert the picture.

2 . On the INSERT menu, point to PICTURE, and then click FROM FILE.
3 Locate the file that contains the picture you want to insert.

4 Click the picture you want to insert.
5

. To place the picture in the drawing layer—so you can position it precisely on
the page or in front of or behind text or other objects—select the Float over
text check box.

To insert the picture directly in the text at the insertion point—or inline—clear
the Float over text check box.
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TIP

You can reduce the size of a file by linking a picture instead of inserting it. In the
Insert Picture dialog box (Insert menu, From File submenu), click the picture,
select the LInk to file check box, and then clear the Save with document
check box. While you can't edit the picture, you can see it in your document and
print it when you print the document.

Change a Floating Picture to an Inline Picture

2

By default, Word inserts imported pictures as floating pictures—pictures that are
inserted in the drawing layer so you can position them precisely on the page or in
front of or behind text or other objects. To change a floating picture to an inline
picture—one that is positioned directly in the text at the insertion point:

Select the picture, and then click PICTURE on the FORMAT menu.

(If you don’t see PICTURE on the FORMAT menu, you need to select the
picture.)

On the POSITION tab, clear the FLOAT OVER TEXT check box.
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Insert a scanned picture

1
2

Your computer must be connected to a scanner to complete this procedure.

Position the insertion point where you want to insert the scanned picture.
On the INSERT menu, point to PICTURE, and then click FROM SCANNER.
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3 Scan your picture. Follow the instructions that come with the scanner you're
using.

4 When the image appears in Microsoft Photo Editor, make any changes you
want.

For example—you can crop the picture, add special effects to it, and adjust its
brightness, contrast, and color. If you need help, use Photo Editor Help.

5 When you finish editing the picture, click EXIT AND RETURN TO on the Photo
Editor FILE menu.

NOTE
If Microsoft Photo Editor is not installed, run the Setup program again and install
it.

Drag Information Between Programs
You can move or copy information, or you can create a linked object, a shortcut, or
a hyperlink between documents in different programs by using drag-and-drop
editing. Both programs must support OLE.

1 Arrange the program windows so that both the source file and the destination
file are open and visible. You must be able to see the information you want to
drag as well as the location where you want to drop it.

2 Select the information, and then use the right mouse button to drag the
selection to the new location in the other program.

3 On the shortcut menu, click the command you want.

Crop or trim portions of a picture
1 Select the picture you want to crop.

[
2 Onthe PICTURE toolbar, click Crop i .

3 Position the cropping tool over a sizing handle and drag.

TIP
If the Picture toolbar isn’t displayed, right-click on the picture, and then click
Show Picture Toolbar on the shortcut menu.

Wrap Text Around a Drawing Object
1 In page layout view, select the text box or drawing object.
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2 On the FORMAT menu, click AUTOSHAPE, TEXT BOX, PICTURE, or OBJECT,
and then click the WRAPPING tab.

3 Under WRAPPING STYLE, click the option you want.

4 Under WRAP TO, click the sides of the text box or graphic you want text to
wrap to.

5 Under DISTANCE FROM TEXT, specify the distance between the text box or
graphic and the text that surrounds it.

NOTE

By default, Word inserts imported pictures as floating pictures—pictures that are
inserted in the drawing layer so you can position them precisely on the page or in
front of or behind text or other objects. To change a floating picture to an inline
picture—one that is positioned directly in the text at the insertion point—select the
picture, and then click Picture on the Format menu. On the Position tab, clear
the Float over text check box.

Layering Text and Graphics

You can use the Bring in Front of Text and Send Behind Text commands on
the Draw menu to layer text and graphics.

To place the selected graphic in front of or behind text:

® (Click the DRAW menu on the DRAWING toolbar, point to ORDER, and then
click BRING IN FRONT OF TEXT or SEND BEHIND TEXT.

Create Transparent Areas in a Picture

5-4

You can use transparent areas to integrate a picture on your page % for example,
when you have a picture of a person and don't want the background color to be
visible.

1 Select the picture you want to create transparent areas in.

2 On the PICTURE toolbar, click SET TRANSPARENT COLOR e .

3 Click the color you want to make transparent.

NOTES

» The Set Transparent Color option is available for bitmap pictures that don't
already have transparency information. It's also available for some, but not all,
clip art.
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* You can make only one color transparent. When printed, transparent areas will
be the same color as the paper they're printed on. In an electronic display—such
as on a Web page or in a PowerPoint presentation—transparent areas will be the
same color as the background.

It might be difficult to see the transparent effect in a photograph because the
color you select may appear in very small areas. What appears to be a single
color, such as a blue sky, can actually be a range of subtle color variations.

INSERTING A SOUND FILE INTO WORDY97
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To insert a sound file into a Word document, you can use Sound Recorder — a
Microsoft Windows accessory that lets you record, edit, and play sound files. To
use Sound Recorder, you must have a sound card and speakers installed on your
computer. If you want to record live sound, you also need a microphone. For more
information about Sound Recorder, click the Help menu in Sound Recorder.

Insert a Sound File into a Word Document

1

Open both the Word document and the Sound Recorder sound file you want
to insert.

To open Sound Recorder from the Windows 95 START MENU, select:
PROGRAMS>ACCESSORIES>MULTIMEDIA>SOUND RECORDER.

Switch to Sound Recorder, and click COPY on the EDIT menu.
Switch to Word, and click where you want to insert the sound file.

To insert the sound file as an embedded object, click PASTE on the EDIT
menu.

To insert the sound file as a linked object, click PASTE SPECIAL on the EDIT
menu. Click PASTE LINK. In the As box, click WAVE SOUND OBJECT.
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NOTE:
To play a sound file, double-click its icon.

Microsoft Sound Recorder

Jq asknot.wav - Sound Recorder -] Ix

Fila Edit Effects Help

Position; _ Length:
0.25 sec. — 8.66 sec.
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i ! !
Rewind Fast Forward Play Stop

INSERTING A VIDEO FILE INTO WORD 97
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You can insert a video file into a Word document by using Media Player, a
Microsoft Windows accessory that lets you play audio, video, or animation files.

To use Media Player, you should have a sound card installed on your computer. For
more information about Media Player, click the Help menu in Media Player.

Insert a video file into a Word document

1

N O g s W

Open both the Word document and Media Player.

To open Media Player from the Windows 95 START MENU, select:
PROGRAMS>ACCESSORIES>MULTIMEDIA>MEDIA PLAYER.

Switch to Media Player, and then click VIDEO FOR WINDOWS on the DEVICE
menu.

Open the video file you want to insert.

On the EDIT menu, click OPTIONS, and then specify the options you want.
On the EDIT menu, click COPY OBJECT.

Switch to Word, and click where you want to insert the video file.

To insert the video file as an embedded object, click PASTE on the Edit menu.
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NOTES

To insert a video file as a linked object, click OBJECT on the INSERT menu,
and then click the CREATE FROM FILE tab. Select the video file you want, and
then select the LINK TO FILE check box.

To play a video file, double-click its icon.
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MICROSOFT CAMCORDER
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If you installed Office from a CD-ROM, you can install and use Microsoft
Camcorder to record actions, procedures, and sounds that you perform on your
computer. You can save the recording as a movie that you can then play in
Camcorder, or you can save the movie as a stand-alone program that you can send
to others to play, even if they don't have Camcorder. For example, you can use
Camcorder to create a computer tutorial that you can send to others to use. You can
set preferences for movies that you record, such as the keys to use to stop
recording a movie, the quality of the sound you record, and whether to show
Camcorder in front of open programs.

Although you cannot run Camcorder on Microsoft Windows NT Workstation, you
can play a movie that has been recorded in Camcorder as a stand-alone program.
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For information about how to use Microsoft Camcorder, see Microsoft Camcorder
Help.

NOTE

If you have not already installed Microsoft Camcorder, insert the Microsoft Office
CD-ROM in your CD-ROM drive, and then run Microsoft Camcorder Setup. To do
this, double-click the ValuPack folder on the CD-ROM, double-click the MSCam
folder, and then double-click Camcordr.exe. To start Microsoft Camcorder, click
the Windows Start button, point to Programs, and then click Microsoft Camcorder.
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POWERPOINT
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PowerPoint is a powerful presentation package. From basic presentations to
delivery on the Web, PowerPoint offers many features that can be used in research
results, training development and project presentations. There are even tools
available in the package to convert any presentation for delivery on the Web, either
as an animated PowerPoint presentation or as HTML/GIF pages.

Using Templates

Use ready-made design templates and layouts to create text presentations. The
built-in templates make it easy to generate professional-looking text slides that

organize and summarize your main points.

Every time a new slide presentation is created, you must select a presentation type.
Once a design is chosen, every new slide within this presentation will use this

design unless you opt to override this default.

1 Select “New...” from the File menu. A “New Presentation” window should

appear.

2  Click the “Presentation Designs” tab. A selection of ready-made design

templates will appear.

3 Click on a design template once to view a thumbnail example of it in the right

hand portion of the window.
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4 ' When you have found a design you want, click the “OK” button and a “New
Slide” window will appear.
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Choosing a Layout for the Slide
Every time you create a new presentation or insert a new slide, you must choose a
layout. The choice of a layout, unlike the choice of a design, applies only to one
slide. Different layouts afford different types of media. Some layouts contain
merely text with a header. Others can combine text and clip art or other media
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objects (i.e., QuickTime movies, Excel charts, Word tables). Select a layout that
best fits your slide content.

Mew Slide Rﬁ

Choose an Autolayout:

Cancel

Hift
Hift
Hift

Title Slide

e

Saving Your Presentation as HTML
PowerPoint has the ability to save your presentation as a group of files which can
be uploaded to the Web.
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1 With your presentation open, select “Save as HTML...” from the File menu.
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2 A “Save as HTML” window will appear. It will act as your graphical map
through the process. The “Office Assistant” may also appear offering some
anemic help. Tell it to go away by selecting “No” in its dialog box.

3 Select the “Standard” option. It is more compatible with older Web browser
versions and smaller screens. Click the “Next” button.

4 Follow the selections on the screen as appropriate for your presentation. If
there are no inserted photographs in your presentation, use the “GIF” option.
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You may have to experiment with the different screen size settings for your

particular use and audience.
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Once you click “Finish”, the process will export a copy of your presentation
in HTML format. The result is a folder of files. These will have to be uploaded
to your web site for consumption by your audience. .
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You should check your version in your own browser. Open the file in the
directory call “index.htm” and browse your presentation!
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Viewing and Navigation in PowerPoint

In PowerPoint there are many different ways to create, view, and navigate your
slides, depending on what you want to do to a single slide or to multiple slides.

There are six primary ways to view a PowerPoint presentation as it is being
created/edited. Five of these views can be accessed from the button bar in the lower
left corner of the document window. The sixth, the Slide Master view, is special
and is accessed via a menu. Each of these views have certain advantages and
disadvantages.
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Slide View: This is the most common view for editing because objects on the slide
can be easily manipulated.
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Outline View: Presentation outline can be created and edited here. Use the blue
arrows in the PowerPoint button bar to indent and outdent items.
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Slide Sorter View: The Slide Sorter View is analogous to a light table. This
view has many helpful functions. Slides can be inserted or deleted. Slides can be
rearranged by clicking and dragging (or, alternatively, cutting and pasting). The
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Slide Sorter View is also a good view to apply text builds and transitions since the
overall flow of the presentation can be seen with the thumbnails.
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Notes View: The notes view is handy for a presenter. Text can be entered under
an image of each slide for speaking notes or in-depth handouts to learners.
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Slide Show View: This view is the full screen presentation mode for the slide
show. It can be used as a dress rehearsal for transitions and text builds.

Slide Master View: This view is similar to the Slides View, but all changes made
to this view are global. That is, when something is changed in this view it will
change for every slide in the presentation. This is helpful for consistency of
formatting elements (e.g. fonts, position of titles, departmental logo, boilerplate
text, etc.). It also creates a more efficient PowerPoint file size since a global
element is only saved once rather than for every slide on which the element
appears. The Slide Master View is accessed through the Slide menu.

Basic PowerPoint Tips

Tired of having to click on the mouse.... try these Keyboard Shortcuts. If your
selection already exhibits this behavior, these keyboard shortcuts will reset the

behavior

~ €

Select all Ctrl+A
Copy all selected data Ctrl+C
Cut all selected data and place it on the Clipboard Ctrl+X
Undo the last action Ctrl+Z
Repeat Jast action/last typing Ctrl+Y
Begin a New document/spreadsheet/presentation Ctrl+N
Make new slide Ctrl+M
Open an existing document/spreadsheet/presentation Ctrl+O
Save Ctrl+S
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Close the item you are working on without Exiting Ctrl+W
In PowerPoint: Quit/Exit Ctrl+Q
Print Ctrl+P
Make the selected item Bold Ctrl+B
Italicize the selected item Ctrl+I
Center a paragraph Ctrl+E
Underline the selected item Ctrl+U
Justify paragraph Ctrl+J

~ Left align paragraph Ctrl+L
Right align paragraph Ctrl4+R
Find Ctrl+F
Replace Ctrl+R
Nudge an item Ctrl+Arrow Key
Go To Beginning Ctrl+Home
Go To End Ctrl+End

Adding music, sounds, and videos
PowerPoint comes with music, sounds, and videos you can play during your slide

shows. Some sounds such as a typewriter or applause are available on the
Animation Effects toolbar. Other sounds, as well as music and videos, are available
in the Clip Gallery. To use the Clip Gallery, point to Movies and Sounds on the
Insert menu, and then click either Movie from Gallery or Sound from Gallery.
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You can insert a music, sound, or video clip on a slide where you want it to play
during a slide show. By default, the sound or video starts when you click its icon
during a slide show. To change how the clip starts or to add a hyperlink to the clip,
click Action Settings on the Slide Show menu.
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You can also add animation effects and change play settings by clicking Custom
Animation on the Slide Show menu. For example you can set a sound or video to
play automatically in an animation sequence.

Sounds, music, and videos are inserted as PowerPoint objects. To play a sound or
video as a Media Player object instead, click Object on the Insert menu, and then
click Media Clip. This method uses the Media Player installed with Windows 95 to
run the sound or video. The Media Player plays multimedia files and controls such
playback devices as compact disc and video disc players. For more information
about the Media Player, use Media Player Help.

PowerPoint can support .wav and MIDI (Musical Instrument Digital Interface)
files. Long wave files take up a lot of disk space. MIDI, on the other hand, defines
the codes for a musical event, which includes the start of a note, its pitch, length,
volume and musical attributes, such as vibrato. It also defines codes for various
button, dial and pedal adjustments used on synthesizers. MIDI files (.mid) also
take up much less disk space than sound files that contain the actual digitized
music.

Record a voice narration or sound in a slide show

6-12

You might want to add narration to a slide show for any of the following reasons:
¢ For individuals who can't attend a presentation

» For self-running slide shows

» For gaining access to a slide show on the Internet

* For archiving a meeting so presenters can review it later and hear comments
made during the presentation

To record a narration, your computer needs a sound card and a microphone. You
can record a narration before you run a slide show, or you can record it during the
presentation and include audience comments. If you don't want narration
throughout the entire slide show, you can also record separate sounds or comments
on selected slides or objects.

If you decide to change something in the narration you've recorded, you'll need to
delete the entire narration and rerecord it. Because voice narration takes
precedence over all other sounds, if you're running a slide show that includes both
narration and other sounds, only the narration will be played.
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Record a voice narration
1 On the Slide Show menu, click Record Narration. A dialog box appears

showing the amount of free disk space and the number of minutes you can
record.
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2 To insert the narration on your slides as an embedded object and to begin
recording, click OK.

3 To insert the narration as a linked object, select the Link narrations in check
box, and then click OK to begin recording.

4 Advance through the slide show and add narration as you go. At the end of
. the show, a message appears.

5 To save the timings along with the narration, click Yes. To save only the
narration, click No. A sound icon appears in the lower-right corner of each
slide that has narration.

‘When you run the slide show, the narration will automatically play with the show.
To run the slide show without narration, click Set Up Show on the Slide Show
menu, and then select the Show without narrations check box.

Because you can't record and play sounds at the same time, while you're recording
you won't hear other sounds you inserted in your slide show.
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Record a sound or comment on a single slide

Adding Videos

To do this procedure, you'll need a microphone.

In slide view, display the slide you want to add a sound to.

On the Insert menu, point to Movies and Sounds, and then click Record
Sound.

To record the sound, click Record .
When finished, click Stop .

In the Name box, type a name for the sound, and then click OK. A sound icon
appears on the slide.

To animate the sound so it plays automatically in an animation sequence,
select the sound icon, click Custom Animation on the Slide Show menu, and
then select the options you want.

PowerPoint always needs a copy of the video file in order to play it. When using a
video as part of your presentation, keep a copy of the video in the same folder as
your presentation!! This will speed up the loading process, and ensure PowerPoint
can always find the video if you switch computers. If the video cannot be found,
the presentation will be interrupted by a "Find File" message.

To place on your slide:
Go to tﬁe Insert Menu and choose Video
Choose From File, and select a .avi file
The opening frame will appear on your slide
OR
Open an AVI file in Media Player
Choose Copy in the Edit Menu
Go to a PowerPoint slide and choose Paste
To appear on cue
Place the video on the slide, as detailed above.
Select the video (click on it) and go to the tools menu and animation settings
Choose to build and then pick an effect - fly in, dissolve in, etc.

To play when a page loads
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1 Place the video on the slide, as detailed above.
2 Select the video (click on it) and go to the tools menu and interactive settings

3 In the Play menu click on options, and play upon load is a choice there.

About animating text and objects
You can animate text, graphics, sounds, movies, and other objects on your slides so

you can focus on important points, control the flow of information, and add
interest to your presentation. You can have each main bullet point appear
independently of others, or you can have objects appear progressively, one after
another. You can set up the way you want each bullet point or object to appear on
your slide to fly in from the left, for example and whether you want other bullets or
objects to dim or change color when you add a new element.

You can also change the order and timing of your animations, and you can set them
to occur automatically without having to click the mouse. To set up and preview
the animation of your text and objects, click Custom Animation on the Slide Show
menu.

Slide show design guidelines
When you give a slide show, the content should be center stage. You want the tools
you use such as animations and transitions to emphasize your points, not draw the
audience's attention to special effects.

Since your audience reads from left to right, you might design your animated
slides so that your points fly in from the left. Then to emphasize a particular point,
try bringing it in from the right. The change will grab the audience's attention and
reinforce your point.

The same principle works with sound. An occasional burst of music or sound
during a transition or animation will focus the audience on the slide show.
However, frequent use of sound effects can draw attention away from your main
points.

The pace of your presentation also affects audience response -- going too fast
exhausts audience members, and going too slow puts them to sleep. You can use
PowerPoint features to rehearse your pace before you give a presentation.

‘While you rehearse, you can also check your slides' visual impact. Too many
words or pictures can distract the audience. If you find yourself using too much
text, try turning one slide into two or three, and then increase the font size.
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Adding Transitions to Slides
You can alert your audience to changes in slides and changes in text as it appears

on the screen by using transitions and builds.

1 Switch to the Slide Sorter View so that you can see all or most of your
presentation.
2 Click once on the slide to which you wish to apply the transition.

3 There is a menu above the slides. Select the transition you desire. Once you
select a transition, the slide will mimic the effect.
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4 More details can be controlled by clicking the button to the left of the pull
down area. Click on the transition icon under the slide to see the transition.
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Create animated slides
You can use the Custom Animation command on the Slide Show menu to set all
the animation effects you want for a slide. For example, you can set text to appear
by the letter, a word, or a paragraph. You can have graphic images and other
objects such as charts and movies appear progressively, and you can even animate
the elements of a chart. You can also change the order in which objects appear on a
slide, and you can set timings for each object.
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Animate text and objects

1

In slide view, display the slide that has the text or objects you want to
animate.

On the Slide Show menu, click Custom Animation, and then click the Timing
tab.

Under Slide objects without animation, select the text or object you want to
animate, and then click Animate.

To start the animation by clicking the text or object, click On mouse click.

To start the animation automatically, click Automatically, and then enter the
number of seconds you want to elapse between the previous animation and
the current one.

Click the Effects tab. If you are animating a chart created in Microsoft Graph,
click the Chart Effects tab. For information about animating the elements of a
chart, click .
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Under Entry animation and sound, select the options you want.

Repeat steps 3 through 6 for every object you want to animate. You can click
the Preview button to see how your animations work.

TIPS

A quick way to create basic animation is to select the object you want to
animate (in slide view), click the Slide Show menu, point to Preset Animation,
and then click the option you want.

To preview animations In slide view, click Animation Preview on the Slide
Show menu. The animation plays in the slide miniature that appears. To
replay the animation, click the slide miniature.

Animate the elements of a chart

N OO N s

You can animate the elements of a chart created with Microsoft Graph.
Select the chart you want to animate.

On the Slide Show menu, click Custom Animation, and then click the Chart
Effects tab.

Under Introduce chart elements, select how you want to animate the chart.
Options in the list change depending on the type of chart selected.

Under Entry animation and sound, select the options you want.
Click the Timing tab.
To start the animation by clicking the chart, click On mouse click.

To start the animation automatically, click Automatically, and then enter the
number of seconds you want to elapse between the previous animation and
the current one. The timing you set is also the time that will elapse between
each animated element of the chart.
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Change the order in which animated objects appear on a slide
1 In slide view, display the slide you want to change the order in.

2 On the Slide Show menu, click Custom Animation.

3 Under Animation order, select the object you want to change, and then click
one of the arrows to move the object up or down In the list. Repeat the
process for each object whose order you want to change.

Add an effect to an animated object after it appears
1 In slide view, display the slide you want to add an effect to.

2 On the Slide Show menu, click Custom Animation, and then click the Effects
tab. '

3 Under Animation order, select the object you want to add an effect to, and
then click an option under After animation.
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You can create animated text effects that move or flash for documents that will be
read online. The animated effects do not print.

Select the text you want to animate, or click the word you want to animate.

On the Format menu, click Font, and then click the Animation tab.
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Click the effect you want in the Animations box. You can apply only one
animation effect at a time. To remove an animated effect, select the text, and
then click None in the Animations box.

Microsoft PowerPoint Animation Player for Active X

The ActiveX Animation Player for Microsoft PowerPoint is an easy way for you to
publish and view PowerPoint animation and presentations in Web pages. Thisisa
free browser extension available from Microsoft. With this extension, you can take
advantage of enhanced animation, hyperlinks, special effects and built-in sound
from PowerPoint to build dynamic Web pages. The Animation Publisher allows

you to compress presentations prior to posting on your Web Server.

Here are a few suggestions.

* Animate an image map for your home page with hyperlinks to other places.
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* Create your home page in PowerPoint, and then add animations and sound.
» Create an animated navigation bar.
» Add small animations to liven up your existing page.

 Create ads for your Web sites that attract attention and make good use of the
space.

» Put your presentation on the Internet or an intranet so others can view them in
full fidelity.

* Add narration to your presentation by using RealAudio, ActiveMovie™, or a
WAV file.

This is different than publishing your presentation to HTML. PowerPoint
presentations converted into GIF and JPEG images is so your presentation can be
viewed by any browser on any platform. However, it strips out all the animations,
transitions, build effects, and multimedia effects.

If your presentations are mostly text and you want people on every platform to be
able to view them, convert using the Save As HTML selection. If your audience is
running Windows 95 or Windows NT and would like to see the full range of
PowerPoint's special effects, use the PowerPoint Animation Player. Or you can use
a combination of both and show your presentations in the fullest fidelity available
on a platform.

Additional Sources for PowerPoint Information

Backgrounds for PowerPoint presentations (gif format)
http://www.colorize.com/download/bg.html

Nice, professional templates and graphics — for free!
http://www.colorize.com/do/free.html

University-based site dedicated to PowerPoint issues — very informative.
http://plato.acadiau.ca/sandbox/ppt/ppt.htm

Lots of movies available from the Popular Mechanics site (has a selection of DOD
videos)
http://popularmechanics.com/popmech/movie2/l HOMEMOVIE.html
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creation. The most popular package is Adobe’s Photoshop, along with

Corel Draw and PaintShop Pro. The only problem for the casual user is
that they are too complex to understand and require a full time commitment to
achieve professional results!

G raphics editing packages are the basis of all professional graphics

PHOTODELUXE
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A new entrant in this area of graphics editing is Adobe’s PhotoDeluxe. Itis a
software package that can be considered Photoshop Light. This section is devoted
to covering some of the features of this package, along with explanations on some
of the graphics terminology used both this and other graphics programs.

The main difference between this package and others is that there are wizard-like
cue cards that help you achieve professional results without being a graphics
professional. It also gives you a chance to create high-end graphics and learn as
you go.
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Layers
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Most of the PhotoDeluxe Business editing tools and special effects change the
entire photo. To change only an area of a photo, you must select that area before
you use the tool. For example, if you want to copy part of a photo and paste it onto
a different background, you have to select the part of the photo you want before
you copy it.

When working with digital photos, making a selection means drawing a special
outline (called a selection border) around the part of the photo you want to change.
Once an area is selected, special effects and painting and editing tools will affect
only that area. Unselected areas will not be affected.

When working with digital photos, making a selection means drawing a special
outline (called a selection border) around the part of the photo you want to change.
Once an area is selected, special effects and painting and editing tools will affect
only that area. Unselected areas will not be affected.

Most graphics packages let you work in layers. PhotoDeluxe Business lets you
create pictures with multiple layers. Each layer is like a transparent sheet of plastic
on which you can place a photo, add text, or paint. The layers are stacked one on
top of the other, and where there are no images on a layer, you can see through to
the layer below. Layers let you experiment freely with different combinations of
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photos, text, and graphics without affecting the photo underneath. You can add,
delete, and rearrange the stacking order of layers.

Image layers Merged image

‘When you add text to a photo, it creates a special layer at the top of the layer stack
(in front of all other layers). This layer is always at the top of your layer stack.
Unlike other layers, you cannot select, delete, or change the stacking order of the
Text layer.

Your most important tool in working with layers is the Layers palette, which shows
you how many layers your picture has, what is on each layer, and provides other
tools for working with layers.

You can use the Blend and Opacity options in the Layer Options dialog box to
blend photos on layers and to create a variety of unique and interesting effects. The
Blend options control how the photo on a layer blends with the photo below it. The
Opacity option lets you make a photo semitransparent so that the photo on the
layer below shows through. You can set these options when you create a new layer.
You can also change these settings at any time.

Publishing with Multimedia 17-3




Special Effects

PHOTODELUXE
PhotoDeluxe

There are a more limited number of special effects in PhotoDeluxe than there are
in Photoshop, but that’s still okay — there are lots and you have control over aspects
such as color and special effects.

Here is a table enumerating the different special effects that can be found in

PhotoDeluxe:

Accented Edges Find Edges Reduce Graininess
Bas Relief Fragment Remove Moire Pattern
Blur Funnel Remove Red Eye
Blur More Glowing Edges Ripple

Chalk & Charcoal JPEG Clean Up Sharpen

Chrome Mezzotint Sharpen Edges -
Circular Mosaic Sharpen More
Cloud Texture Motion Blur Shear

Clouds Negative Soften

Colored Pencil Neon Glow Solarize

Crackle Noise Sphere

Crystallize Note Paper Sponge

Despeckle Page Curl Trace Contour
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Diffuse Patchwork Twirl
Dust & Scratches Pinch Unsharp Mask
Emboss Pointillize Variations
Extensis IntelliFix Pond Ripple Wind
Facet Posterize

PhotoDeluxe, Cost: $99.00.
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ADOBE ACROBAT

Readers/Viewers

Producers

as an integrated set of programs which allows you to view, create,

modify, and enhance PDF files that were created in your favorite
applications. Whether you are publishing them on your Web site, intranet, CD-
ROM, or by e-mail you can quickly deliver business documents without re-
authoring or learning new applications.

3 dobe Acrobat 3.0 is actually a family of applications designed to work

These products allow you to print and view PDF files, and in the case of Acrobat
Exchange, you can also enhance the files.

Acrobat Reader is an Acrobat viewer only. There are two versions of Acrobat
Reader; Reader without Search and Reader with Search. Reader with Search is
used when searching indexes created by Acrobat Catalog.

Acrobat Exchange is an Acrobat viewer that lets you modify PDF documents,
enhancing them with hyperlinks, movies, sound, security protection, and
interactive forms. You can also use Exchange for simple text editing and for
correction of captured files.

These products assist you in creating PDF files. Each have distinct advantages and
disadvantages that will be discussed in depth.
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Acrobat Distiller converts PostScript files to PDF documents. Use Distiller
with complex page layout documents or with documents that contain
Encapsulated PostScript (EPS) graphics or images that you need to
compress and re-sample precisely.

PDF Writeris available to you after installing Acrobat Exchange. Acrobat PDF
Writer is a printer driver that “prints” PDF files using the standard application
Print command. Use PDF Writer for fast conversion of simple text business
documents to PDF.

" Designed for production conversion, Acrobat Capture turns paper documents

into PDF files ready for distribution on the World Wide Web, corporate
intranets, CD-ROM, or e-mail. Capture provides the tools to quickly scan and
OCR documents, preserving the graphics, formatting, and layout.

This products allow more fluid access to the information in your PDF documents.
Using Catalog to build indexes to enable full-text search makes your documents
highly usable by your intended audience.

» Acrobat Catalog enables you to create full-text indexes of PDF document
collections that are searchable using the search query too} that is part of
Exchange and Reader with Search.

The source file or original content of a PDF file is created in any word-processing,
page-layout, office program, or graphical application. The source file is then
converted in one of three ways to PDF:

* PDF Writer
» Distiller/Distiller Assistant

* Capture

WAYS TO CREATE A PDF FILE

PDF Writer is a printer driver, but it creates PDF files instead of a print file with
printer commands. Any application that allows you to print to a printer will allow
you to select and print to the PDF Writer 3.0 driver. After Acrobat Exchange has
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been installed on your system, you will find the additional PDF Writer printer
selection available in your print menu. PDF Writer is used for quick conversion of
simple documents (mostly text). PDF Writer allows you to:

» Create a PDF file from almost any application in Windows 3.1, Windows 95,
and Windows NT.

» Create a PDF file from almost any application on a Macintosh.

» Choose from a list of standard orientation and page sizes or enter values for a
custom page size.
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Distiller and Distiller Assistant ,
Distiller provides you with the ability to set up a production process for converting
large numbers of documents to PDF and select specific compression and
resampling methods for problem documents. You should use Distiller for
documents that contain EPS graphics, bitmap images, or files that have been
optimized to print to PostScript.
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Distiller Assistant makes it possible to print directly to Acrobat Distiller so that
you can create PDF files in one easy step. You can save or automatically view the
new PDF file and specify the PDF file location. Distiller Assistant is also used to
monitor watched folders and for Drag-n-Drop activities.

Capture and Capture Plug-In
Capture and the Capture Plug-in allow you create PDF documents from paper files
or electronic images. When using Capture Plug-In, the scanned or imported image
is converted but all objects remain bitmap pictures within the PDF file. You must
use the Capture feature to further convert the bitmaps into “live” text. This text can
then be edited, copied, and searched.

* The Capture software combined with a scanner is appropriate for heavy
scanning and the processing large amounts of information.

» The Capture plug-in utility is used for light duty scanning and capturing.
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Use Distiller/Distiller
Assistant if...

Use PDF Writer if...

Use Capture Plug-In
if...

Source file is from desktop

Source file was created

Source file is an image file

publishing package using simple a business

application
Source file contains Source file does not For small amount of
graphics contain graphics simple paper documents

There are multiple files to

Your system has limited

Already in Exchange

batch process RAM available working on document
Distiller needs to be shared | Want to produce PDF files

over a network very quickly

Results from PDF Writer

are unsatisfactory

USING OPTIMIZED FILES IN ELECTRONIC

PUBLISHING
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Up until the introduction of optimization and byte-serving, the debate on whether
or not to use PDF as the format for electronic delivery of documentation leaned
heavily toward not using it. HTML seemed the better choice because of filesize
and the time it took to download large files. Users without powerful machines,
storage, RAM, and fast intemet connections to handle the transfer of large PDF
files were inclined to request HTML versions of the required documents.
Companies responded to their customers frustration by sticking with HTML.

Of course, HTML could not deliver the document design and layout that these
same companies had spent many dollars and man-hours to create for the print

versions. More money had to be spent after the print version was delivered to “re-
author” the HTML version. Some companies decided to offer both formats, HTML
and PDF, but this created another problem - version control or configuration
management. With a new revision of a document, both versions had to be updated
and made available. Now three copies of a document existed; the source, the PDF
file, and the HTML. Storage capacity on the servers entered the picture as a new
issue to deal with. The online population was becoming irritated with PDF.

Acrobat 3.0 and optimization solves all three issues; downloading time, version
control, and storage capacity. Because of byte-serving, users need not wait to
download the entire file. The user gets the file as it was printed in better time. Due
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to better compression in Acrobat 3.0, the filesizes of PDF files are much smaller
and sometimes not that much bigger than the HTML version.

What is Byte-Serving?
Today, any PDF file on any Web server can be accessed and viewed with Acrobat
3.0. However, only PDF files that have been “optimized” allow the user to
progressively access and view each page as it downloads into an Acrobat 3.0-
compatible Web browser.

Optimized PDF files are served from websites through a properly configured
WWW server. The configuration implements a technology called byte-serving.
Byte-serving is part of an Internet standard (RFC 2068 - "Byte Range Retrieval
Extension to HTTP") that allows partial transfers of complex documents.

Byte-Serving Optimized Files
‘When a user’s browser finds a PDF page on a web site, the browser launches
Acrobat viewer. The first thing the server does is send the viewer the Hint Table of
the objects for that page. The Acrobat viewer uses this table to request from the
server the specific parts of the file needed to display a particular page. This process
is invisible and almost instantaneous to the user.

This means that the Web server locates and sends only the requested page - one
page-at-a-time - for the user to view, rather than the whole document.

Optimized PDF files are progressively rendered as the page downloads.
Progressive rendering first displays text, then graphics, then navigational elements,
then images, the fonts, and finally the thumbnails. In addition, redundant objects,
such as logo graphics, are eliminated, thereby saving space in the PDF file, and
time in display!

Once you have control in the Acrobat window, you can jump to any other page.
The request for that page is sent to the server, and it is downloaded. As you are
navigating, the file is completing its full download. The progressive rendering of
the PDF file means that you spend less time viewing a blank screen, and more time
absorbing what is being displayed.

Optimized PDF Documents
If you plan on publishing over the Web, you need to optimize your PDF files. The
Save As command now includes an option for optimizing PDF files for online
delivery. Optimization involves consolidation and reordering the information in a
PDF file. This does not change the outward appearance of the file. Duplicate
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background objects (text, line art, and images) are consolidated to reduce the file
size significantly and objects in the PDF file format are reordered for byte serving

over the Internet.
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In the Acrobat Exchange Save As Dialog Box, the optimize button is at the right.

The file’s optimization status is indicated in Document Info under General. File is
optimized as indicated by the “Yes” in the lower left of the screen.

ENHANCING PDF FILES
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We will explore the ways we can make the online representation of our print
documents work for us. We will become acquainted with the navigational and
interactive tools available that create dynamic and useful electronic versions of our
original documents.

For instance...

I distribute a 300-page document on CD. My files were created in my publishing
application of choice, PageMaker. This document is design- and layout-intensive
and it contains many graphics. The document is separated into 3 files because the
file size of one single file would be incredible. My customers don’t read the entire
document. They are looking for specific pieces of information to print out.
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If you were that customer, how would you go about getting the information? If you
have PageMaker installed on your system, you can open each document separately
and use the Find Text feature or manually page through the documents to try and
find the information you need.

Instead...

Convert the three PageMaker files to PDF. Merge them together to make one,
much smaller file. Insert links in the Table of Contents to related information,
references, etc.

Open the PDF document using the free Acrobat Reader (eliminating the need for
PageMaker), use the find feature, and find the location of the information that I
desire in one find - not three.

If I know what section the information is in, I can simply click on the link in the
Table of Contents and jump there instantly. The time I used to spend trying to find

.. the information is now spent utilizing the information.

HYPERTEXT LINKS
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Hypertext is the ability to jump from one place to another within a document.
Acrobat gives you the ability to create hypertext in the form of links and
bookmarks.

Bookmarks are hypertext links with associated icons and name labels. They can
act as a navigation aid for a set of PDF files or as an electronic table of contents
(TOC) for a single document. Bookmarks can be nested to represent the logical
hierarchy of a TOC and can perform many actions other than jumping from one
section of a document to another. They can be constantly modified, edited, deleted,
and created at any time by Exchange users having permission to modify the PDF
file.

Displaying Bookmarks

By clicking the Bookmarks and Page button, you will be given two windows. The
document window is displayed on the right and an overview window with any
bookmarks is displayed on the left.
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Bookmarks are made up of an icon and label. Certain actions can be taken
depending on whether you select the icon or the label.

If the label Is selected, the action of the bookmark Is performed.

If you have been changing the text of the label, you might not be able to click
on the label to execute the action of the bookmark. Click elsewhere in the
overview window and then click again on the label.

.

If the icon Is selected, you can:

Move
Change the properties
Delete

Copy. Bookmarks cannot be copied within the overview window or out to
another document.

Edit the label. After you have selected the icon, select the label. The text of the
label is highlighted and you can change the text. You cannot change the font of
bookmark name labels.
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Diagram of a Bookmark

In a new session of Acrobat Exchange, the default setting for bookmark action is
Go To View, the default magnification is the same as the open file magnification

- set in Document Information.

* During a session, the default settings for newly created bookmarks are the same

as those for the last bookmark created. There are a number of ways to create a
bookmark.
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 Create a new bookmark and type in the text for the label.
» Copy text from the document and create a new bookmark.

» Create a new bookmark and copy and paste new text into the label.

NOTE:
The destination of a new bookmark defaults to the page currently displayed at the
time the bookmark is created.
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MOVIE PLUG-IN
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This plug-in gives the user the ability to play a movie in a defined area within a
PDF file. Currently, QuickTime and AVI are the supported formats. MPEG is not
supported but there are utilities out on the WWW that convert MPEG format to
AVL

Users viewing PDF files with movies control must have the QuickTime 2.0+ or
Microsoft Video for Windows software.
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How the Movie Plug-In Works

The movie file itself is not embedded in the PDF file. In other words, you are not
making the movie file part of the PDF file. You are merely adding a control to the
PDF file that will play an external movie file. This is very important to remember.
The movie file must travel with the PDF file in order for the control to work.
Otherwise, the user will get an error.

If the PDF file is being served over the WWW, the movie file will have to be
downloaded before the playback commences.

How to Link to the Movie Control

When creating any kind of link (Bookmarks, Hypertext links, and Forms) you can
choose to have them perform an action on a movie control. Links can play, stop,
resume, or pause a movie control. A Movie control must exist prior to creating a
link to it.
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Extending Your Use of Acrobat with Plug-ins

A plug-in is a special piece of add-on software. The plug-ins enhance the
functionality of Acrobat. Some products let you create links and bookmarks, add
markup annotations, navigate, and copy information. Products like Compose,
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Aerial and Re:mark, can help you get your Acrobat processing job done faster; and
they let you do things you just can't do with Acrobat alone.

You must first own Adobe Acrobat Exchange before you can use the plug-in
products. Some plug-in products work partially with the free Acrobat Reader, but
in most cases you need Acrobat Exchange.

Aerial complements and extends Acrobat's navigation, print and text extraction
features. Print large spreadsheets or CAD drawings over multiple tiled pages. Copy
tables to spreadsheets. Convert PDF text into RTF for editing with Microsoft Word
or other word processors. (Note: Aerial works with either Acrobat Exchange or
Acrobat Reader. Some features are not available when used with Acrobat Reader)
(www.infodata.com). Cost: $49.00.

Compose streamlines your PDF document production. With powerful tools that
are easy to use, Compose automates repetitive tasks like bookmarking, hypertext
link creation and more. See a review of Compose in Jan/Feb 97 issue of Adobe
Magazine. Compose is a must-have for professional PDF publishers and CD-ROM
creators. (Note: Compose does not work with the free Acrobat Reader)
(www.infodata.com). Cost: $495.00

Re:mark is a redlining tool for document review in a workgroup setting. Add
annotations like hilites, strike-thrus and comments directly on the screen and
eliminate paper drafts completely. Now you can distribute documents for review,
and receive comments back electronically. (Note: Re:mark does not work with the
free Acrobat Reader) (www.infodata.com). Cost: $129.00
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HIGH END MULTIMEDIA

hat does both the entertainment industry and the manufacturing
\; \/ industry have in common? They have been the early adopters of high-
end multimedia products and systems. Examples are fly-bys around
Saturn, inner workings of jet engines, Hubble telescope images, and computer
animated modeling of DNA cells and structures — even CAT scans and MRI
imaging. These products are typically created with CAD/Modeling-based
systems.

HIGH END MULTIMEDIA DEVELOPMENT
ENVIRONMENTS
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The early adopters of this technology were the scientific community more than any
other. These people invented the technology they needed to solve their own
research visualization problems.
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In this section, high-end graphics will be discussed, as well as high-end
multimedia authoring systems.

Computer-Aided Design
A great example is in the building industry. For instance, most people cannot

visualize what a construction project will look like after completion by simply
looking at a set of construction plans or two-dimensional elevation drawings.
Computer-generated 3-D renderings solve this problem. They are also much more
accurate than the average hand-drafted rendering since they are modeled using
CAD (Computer-Aided Design) technology, therefore generating perspective
views with correct object placement and shadow casting from any given point of
view. Another advantage over hand drawings is that if additional renderings from
different points of view are desired, or if revisions need to be made to the final
rendering, all that needs to be done is to reposition and/or modify the computer
model as desired and render it again.

This section offers an introduction into this world. If you wish to learn more about
these topics, please follow the links in the documents.
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In all high-end multimedia, the roots are in 3D Graphics. What's 3D graphics,
anyway? It is the creation and combination of geometry, transformations,
attributes, lighting, shading, and textures.

Geometry is defined by XYZ coordinates and some additional semantics.
Geometry has properties - specifically, "material” properties describe how light
reflects of off the surface of an object.

Transformations (scale, rotate, translate) can be used to position and scale objects
in relation to others.

Lighting is the process of determining how much light strikes an object and how
much should be reflected. There are spot lights, light bulbs and sun light. There is
also ambient light to simulate what we call diffuse light. These different lighting
effects can be combined to create realistic shadows, rather than harsh, hard edge
shadows.

Shading determines how the colors - determined in the lighting step — are spread
across the surface.
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Texture is the tactile nature of the surface, and this has an effect on the subtle
shading and lighting properties in the rendered graphic.

Virtual Reality and Simulation Systems
Virtual Reality is high-end graphics that humans can experience with the use of
visors, gloves and other body systems. An example that is in use at Chrysler today
is one of modeling the interior of new automobiles and testing the human factors of
the design before the car is manufactured! The U.S. Department of Defense has
really been in the forefront of creating computer simulations for training purposes.
Lots of simple mistakes can be alleviated, resulting in lower overall costs, using
this technology.

The backbone of these systems is Computer-Aided Design. Again, special
purpose software is developed specifically for this use. A company known for its
innovative workstations and software is Silicon Graphics (http://www.sgi.com)
and Intergraph Corporation (http://www.intergraph.com).
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One company that has created and perfected the 3D modeling and animation
market is Pixar (http://www.pixar.com). This is the company that was created by
Steve Jobs (Apple) and has brought wonderful animated classics such as Toy Story.
Luxo Jr. (1986) was the first three-dimensional computer animated film to be
nominated for an Academy Award, in addition to winning some 20 awards at
international film festivals. It includes several technical achievements in computer
animation, most notably self-shadowing, where an image accurately casts shadows
onto itself. Final images were rendered with multiple light sources and motion
blur.

Tin Toy (1988) is the first computer animated film ever to win an Academy Award.
It tells the humorous story of a wind-up toy's first encounter with a boisterous
baby. Animation of the baby's facial expressions was accomplished by defining
more than 40 facial muscles on the computer which the animator controls.
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The tools that Pixar uses are ones that they created themselves — and they are
expensive! The RenderMan suite of tools is $8,500.00. RenderMan is the
Academy Award-winning software used by motion picture and television studios
to create realistic visual effects. Used in conjunction with popular modeling and
animation software, Pixar's RenderMan has allowed digital design studios to create
landmark visual effects such as the cyborg in Terminator 2, the dinosaurs in
Jurassic Park and the animals in Jumanji.

Pixar's RenderMan was engineered from the onset to create the world's most
compelling and highest quality computer generated images for use in feature film
and television effects. RenderMan images are free from the typical computer
defects of aliasing, strobing and unrealistic visual simplicity. Instead, RenderMan
images are capable of representing subtle visual attributes such as materials and
textures, the influence of various types of lights from multiple sources, shadows,
camera effects and other features not properly described by shape alone.

In 1995 Pixar released Toy Story, the world's first entirely computer generated
feature film. The entire film was rendered with RenderMan, because it is the only
renderer currently available that is robust enough to create a feature film. The
complex, realistic 112,000 frames in Toy Story contained more than 400 models,
‘more than 1,500 RenderMan shaders and over 2,000 texture maps. A model file for
a typical frame in this movie was 15MB, far more complex than can be handled by
most commercially available rendering systems. The computer hardware that is
used is also specialized, created by Silicon Graphics (http://www.sgi.com),
although many Unix platforms can also be used. Sometimes rendering is
accomplished over hundreds of machines at the same time!
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Bringing James Cameron's period epic to the screen required the ultimate in
special effects. A computer-generated ocean, thousands of computer-generated
extras on deck, and match-moving the shots of actors on a deck set-piece with a
45-foot ship's model were the work of a large creative team. In fact, even the “fog
breath” from the actors was computer-generated. More than 300 Silicon Graphics
workstations were used by digital artists running software from AliaslWavefront,
Softimage, Avid and Side Effects for content creation and compositing.

VRML - Virtual Reality Modeling Language

VRML stands for Virtual Reality Modeling Language. It is usually pronounced "V
RML", but its friends pronounce it "vermel." The goal of VRML is to create the
infrastructure and conventions of cyberspace, a multi user space of many virtual
worlds on the Net. Just as HyperText Markup Language (HTML) led to a
population explosion on the Internet by implementing a graphical interface,
VRML adds the next level of interaction, structured graphics, and extra dimensions
(z and time) to the online experience. The applications of VRML are broad,
ranging from prosaic business graphics to entertaining web page graphics, to
manufacturing, scientific, entertainment, and educational applications, and of
course to 3D shared virtual worlds and communities.

VRML, sometimes pronounced vermal, is an acronym for the Virtual Reality
Modeling Language. Technically speaking, VRML is neither virtual reality nor a
modeling language. Virtual reality typically implies an immersive 3D experience
(such as a head-mounted display) and 3D input devices (such as digital gloves).
VRML neither requires nor precludes immersion. Furthermore, a true modeling
language would contain much richer geometric modeling primitives and
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mechanisms. VRML provides a bare minimum of geometric modeling features
and contains numerous features far beyond the scope of a modeling language.

So if VRML is not virtual reality or a modeling language, what is it? There are
several answers to this question. At its core, VRML is simply a 3D interchange
format. It defines most of the commonly used semantics found in today's 3D
applications such as hierarchical transformations, light sources, viewpoints,
geometry, animation, fog, materjal properties, and texture mapping. One of the
primary goals in designing VRML was to ensure that it at least succeeded as an
effective 3D file interchange format.

The second answer is that VRML is a 3D analog to HTML. This means that
VRML serves as a simple, multiplatform language for publishing 3D Web pages.
This is motivated by the fact that some information is best experienced three
dimensionally, such as games, engineering and scientific visualizations,
educational experiences, and architecture. Typically these types of projects require
intensive interaction, animation, and user participation and exploration beyond
what is capable with a page-, text-, or image-based format (i.e., HTML).

Another answer is that VRML provides the technology that integrates three
dimensions, two dimensions, text, and multimedia into a coherent model. When
these media types are combined with scripting languages and Internet capabilities,
an entirely new genre of interactive applications are possible. A 3D metaphor
presents a natural user experience that supports classic two-dimensional (2D)
desktop models as well as extends into broader contexts of space and place. Many
have speculated that the 3D world model will supersede and thus replace the
popular 2D desktop model as the primary user interface paradigm in the next
decade. Of course, there are a variety of challenges that need to be overcome
before this is possible, such as 3D user interface and navigation, user training, and
ubiquitous 3D graphics performance.

Sources of VRML Information
VRML Repository (URL is hitp://www.sdsc.edu/viml/).

The VRML Consortium (URL is http://www.vrml.org) VRML-o0-Rama!! (URL is
http://www.well.com/user/spidaman/vrml.html) is a collection of links & personal
notes.

WWW Viewer Test Page provides sample URLSs for a wide variety of content. This
allows you to test your browser and how it hands data off to helper applications. It
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also has some other MIME pointers. Check out (URL is http://www-
dsed.llnl.gov/documents/WW Wtest.html)

The Mesh Mart has a catalog of objects. They also maintain an excellent list of
pointers in the VRML page. (URL http://www.meshmart.org/)

Viewpoint Datalabs has a library of models and software. (URL is
http://www.viewpoint.com)

Multimedia Authoring Systems
An Authoring System is a program which has pre-programmed elements for the

development of interactive multimedia software titles. Authoring systems vary
widely in orientation, capabilities, and leaming curve. There is no such thing (at
this time) as a completely point-and-click automated authoring system; some
knowledge of heuristic thinking and algorithm design is necessary. Whether you
realize it or not, authoring is actually just a speeded-up form of programming; you
don't need to know the intricacies of a programming language, or worse, an API,
but you do need to understand how programs work.

Each of these authoring programs work with a different paradigm, or an authoring
metaphor. This is the methodology by which the authoring system accomplishes
its task. There are various paradigms, including:

» Scripting Language - The Scripting paradigm is the authoring method closest
in form to traditional programming. The paradigm is that of a programming
language, which specifies (by filename) multimedia elements, sequencing,
hotspots, synchronization, etc. A powerful, object-oriented scripting language
is usually the centerpiece of such a system; in-program editing of elements (still
graphics, video, audio, etc.) tends to be minimal or non-existent. The scripting
paradigm tends to be longer in development time (it takes longer to code an
individual interaction), but more powerful interactivity is possible.

* Iconic/Flow Control - This tends to be the speediest (in development time)
authoring style; it is best suited for rapid prototyping and short-development
time projects. Many of these tools are also optimized for developing Computer-
Based Training (CBT). The core of the paradigm is the Icon Palette, containing
the possible functions/interactions of a program, and the Flow Line, which
shows the actual links between the icons. Macromedia Authorware or
IconAuthor, are extremely powerful examples of this type.

* Frame - The Frame paradigm is similar to the Iconic/Flow Control paradigm in
that it usually incorporates an icon palette; however, the links drawn between
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icons are conceptual and do not always represent the actual flow of the
program.

Card/Scripting - The Card/Scripting paradigm provides a great deal of power
(via the incorporated scripting language) but suffers from the index-card
structure, It is excellently suited for Hypertext applications, and supremely
suited for navigation intensive applications. Such programs are widely used for
shareware applications.

Cast/Score/Scripting - The Cast/Score/Scripting paradigm uses a music score as
its primary authoring metaphor; the synchronous elements are shown in various
horizontal "tracks” with simultaneity shown via the vertical columns. The true
power of this metaphor lies in the ability to script the behavior of each of the
cast members. The most popular member of this paradigm is Macromedia
Director, which is used in the creation of many commercial applications. These
programs are best suited for animation-intensive or synchronized media
applications.

Hierarchical Object - The Hierarchical Object paradigm uses a object metaphor
(like OOP) which is visually represented by embedded objects and iconic
properties. Although the learning curve is non-trivial, the visual representation
of objects can make very complicated constructions possible.

Hypermedia Linkage - The Hypermedia Linkage paradigm is similar to the
Frame paradigm in that it shows conceptual links between elements; however, it
lacks the Frame's visual linkage metaphor.

Tagging - The Tagging paradigm uses tags in text files (for instance,
SGML/HTML and WinHelp) to link pages, provide interactivity and integrate
multimedia elements. They tend to have limited tracking capability and are best
suited to online reference material like dictionaries and manuals.

Windows Authoring Systems
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Authorware: Macromedia; Mac, Windows, WWW (via Shockwave). This
follows the iconic/flow control paradigm with a limit per individual file of
32,000 icons. Authorware supports jumping between files (the maintainer has
worked on projects greater than 100 MB in content), jumping out to
applications and even printing from them. This has unparalleled external media
support, and can encapsulate all non-motion media content into applications
and content libraries, or leave media files external for dynamic access.
Authorware supports character-styled text and extensive navigation structures
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including hypertext. This tool is optimal for CBT and rapid prototyping; 4.0's
big plus is (Win-32 only) ActiveX support for the Cracle Video Server
(http://www.macromedia.com/) Full Suite (with Director and other software
packages - $2999.00.
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Director: Macromedia; Mac, Windows, WWW (via Shockwave). This popular
general market product follows the cast/score/scripting paradigm, which makes
it the tool of choice for animation content. Its roots as a cel- and sprite-
animation program are unmistakable; and its inclusion of Lingo, its object-
based scripting language, has made it the animation-capable program to beat.
The AfterBurner compression Xtra creates Shockwave files, allowing Web
playback (http://www.macromedia.com/) $995.00.

Flash: Macromedia; Mac, Windows, WWW (via Shockwave) Flash is a
cast/score/scripting tool, which primarily uses vector graphics (and can create
vector graphics from imported bitmaps). It is optimized for Web delivery, and is
especially common for banner adds and small interactive web deliverables
(http://www.macromedia.com/) $299.00.
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HyperStudio; Roger Wagner Publishing; Mac, Windows. HyperStudio is a
card/scripting paradigm authoring system, optimized for and focussed on the
educational market (www.hyperstudio.com) $199.95.

IMedia infoShip; Windows 3.x, 95, NT. Allows users to use page layout tools
and then bring the pages into a multimedia environment. Features cross-
platform distribution, automatic indexing and storage of page-oriented
documents (www.infoship.com) $589.00.

QuarkImmedia: Quark; PowerMac, Windows Player. QuarkImmedia is a frame
paradigm authoring system, designed for re-purposing print (QuarkXPress)
documents. If you are a Quark user — this is your iool! (www.quark.com)
$660.00.

Toolbook: Asymetrix; Windows, WWW. Toolbook is a card/scripting
authoring system now broken into components: Instructor, the standard tool;
Assistant, the pre-built templates, and Librarian, a course-management system.
Toolbook includes database linkage, MCI compliance and many examples
(called "Widgets") of interactivity. This newest version exports HTML and Java
for Web delivery (http://www.asymetrix.com) $2495.00

IconAuthor: Asymetrix; Windows, NT, UNIX, WWW (via Windows).
IconAuthor follows the iconic/flow control paradigm. It is notable for its
SmartObject editor, which tags content files (still graphics, RTF text, etc.) for
interactivity. It has the option to either embed content files or leave them
external in specified directories. The biggest strength of this program is its
included data handling, which makes it unparalleled for CBT data tracking
(http://www.asymetrix.com) $3995.00.
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» Ray Dream 3D is a 3D rendering program that can model objects,
textures and light sources.
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COPYRIGHT ISSUES

ducators and students are advised to exercise caution in using digital
E material downloaded from the Web in producing educational multimedia

programs or homepages, since there is a mix of works protected by
copyright and works in the public domain. Access to works on the Web does not
automatically mean that the information can be reproduced and reused without
permission or royalty payment and, furthermore, some copyrighted works may
have been posted to the Web without the authorization of the copyright holder.

Statement by Martha Day, Member, CCUMC Government Regulations and Public
Policy Committee, January 1997.

COPYRIGHT AND FAIR USE ISSUES IN
DIGITAL ENVIRONMENTS
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The issues of copyrights in the electronic world are at the center of much debate in
legal, artistic and educational circles. Copyright law is based in the United States
Constitution, Article 1, Section 8. The intention of copyright is “to promote the
progress of science and useful arts by securing for limited times to authors and
inventors the exclusive right to their respective writings and discoveries...”
Exclusive rights include the rights of reproduction, preparation of derivative
works, distribution, public performance, and public display. Within the
Constitution’s concern for authors’ exclusive rights is an equal concem for rights
of users of copyrighted information. Congress included its first codification of
what might constitute reasonable users’ rights in the Copyright Act of 1976,
Section 107 (see below).

Section 107. Limitations on Exclusive Rights: Fair Use

Notwithstanding the provisions of Section 106, the fair use of a copyrighted work,
including such use by reproduction in copies or phonorecords or by any other
means specified by that section, for purposes such as criticism, comment, news
reporting, teaching (including multiple copies for classroom use), scholarship, or
research, is not an infringement of copyright. In determining whether the use made
of a work in any particular case is a fair use the factors to be considered shall
include: 1. the purpose and character of the use, including whether such use is of a
commercial nature or is for nonprofit educational purposes; 2. the nature of the
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copyrighted work; 3. the amount and substantiality of the portion used in relation
to the copyrighted work as a whole; and 4. the effect of the use upon the potential
market for or value of the copyrighted work.

— United States Copyright Act of 1976

Application and Guidelines
Applying the four factors of fair use in any given instance is usually not simple.
The only sure method of establishing a particular action as fair use is through
litigation. However there are guidelines for behavior that have been generally
agreed to be a baseline of safe practice. Guidelines vary according to the particular
function of the copying, such as classroom copying, personal research, or the
creation of course reserves. It allows users of copyrighted materials--teachers,
students, scholars, artists--to use coi>yrighted materials without seeking permission
from the creator or publisher and without paying copyright fees. Fair use allows
scholars to draw on the work of others in advancing a new argument, reviewers to
criticize, artists to parody, teachers to acquaint students with fresh insights. It is
critical for the advance of knowledge and for quality education. Of course there are
limitations, the most basic of which is that the use cannot significantly undercut
what the creator or publisher might gain from commercial sale of the work. The
guidelines also differentiate between individual and institutional behavior.

Unfortunately the guidelines that have been widely agreed upon for many years are
now subject to heated debate because they were developed for use with material
produced in a primarily print environment. From 1994-1997 the higher education
community engaged in intense discussions with associations representing rights
holders in the Conference on Fair Use (CONFU).

CONFU is attempting to work out guidelines for “fair use' in educational and
library settings now that digital, networked communication and publishing is
becoming common, much as, twenty years ago, with photocopy and videotape
technology becoming prevalent, guidelines were negotiated for fair use in
educational and library settings.

On May 19, 1997, the Conference on Fair Use (CONFU) concluded that the
guidelines that had been under development for more than two years had failed to
achieve consensus support. The proposed guidelines, negotiated by various
copyright stakeholders representing creators, publishers, and users of information,
sought to interpret fair use in the development of multimedia works, the creation
and use of digital images, and the transmission of digital media in distance
education. An interim report published by the U.S. Patent and Trademark Office

102 Publishing with Multimedia




COPYRIGHT ISSUES
Copyright and Fair Use Issues in Digital Environments

documents the CONFU process. The interim report may be viewed at
http://www.uspto.gov/web/offices/dcom/olia/confu/.

Using electronic versions of copyrighted materials
There are a few considerations that you should keep in mind when using electronic

versions of copyrighted materials in an educational setting:

1 Every piece of information that is fixed in a tangible medium, whether print,
magnetic tape, or digital, is copyrighted - even listserv postings. No copyright
notice is required for the material to be copyrighted. Just because something
is on the Internet does not mean that is it not copyrighted.

2 One can do anything with the permission of the rights holder. See
http:/www.cetus.org/fair7.html

3 The author Is not always the rights holder. If you are the author you may have
assigned the copyright to the publisher as part of the terms under which the
information was published. You therefore no longer own the rights to your
creation and you cannot use it in ways that are contrary to your agreement
with the legal rights holder.

4 URL links are not covered by copyright. Links may be freely made. However
use of a trademark/logo as the link is not permitted.

5 Classroom copying guidelines state that copying should meet tests for
brevity, spontaneity, and cumulative effect. Copying the same item from term
to term is not permissible. Copying of works intended to be “consumable” in
the course of study s not permissible. See
http://www2.ncsu.edu/ncsu/provost/info/policies/copyright.html

6 Works in the public domain are not copyrighted. Public domain works include
all works produced by the federal government. Some research reports of
work funded by government agencies are In the public domain even though
they appear In a commercial journal. One should verify the status of reports
of government funded research. Materials on which the copyright has expired
are also in the public domain. Generally speaking works published more than
75 years ago are in the public domain. See
http://www.benedict.com/fund.htmifund

7 Fair use In the development of multimedia presentations is a complex issue.
Most experts believe that use of materials in a variety of media for the
preparation and display of classroom presentations can be made without
permission. However if that presentation Is broadcast beyond the other
members of the class, or posted on the Internet for open access, the audience
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is no longer clearly defined as “educational.” It is unlikely to be fair use. See
http://WWW.PeachNet.EDU/admin/legal/copyright/copy.html#part2e8

8 Copying of computer software Is permissible only when it is an essential step
to utilize that program in conjunction with a machine, i.e. to load it on a hard
drive, etc., or for archival purposes. In addition to limitations of fair use, one
must consult the license agreement for that software to be sure that one uses
the program in accordance with the license contract.

The following are sources of information regarding ccpyright issues in the
electronically-connected world of today.

Copyright and Fair Use
http://fairuse.stanford.edu/

Fair Use Guidelines for Educational Multimedia and Related Documents and
Links

http://www.libraries.psu.edu/avs/fairuse/default.html

Basic Principles for Managing Intellectual Property in the Digital Environment

http://www-ninch.cni.org/ISSUES/COPYRIGHT/PRINCIPLES/
NHA_Complete.html

The Intellectual Property and Technology Forum
http://infoeagle.bc.edu/be_org/avp/law/st_orgfipg/iptf/

The Conference on Fair Use - an Interim Report to the Commissioner
http://www.uspto.gov/web/offices/dcom/olia/confu/interim.html

Copyright and Fair Use: Fair Use and Multimedia
http://fairuse.stanford.edu/multimed

Copyright and Fair Use in the Digital Age
http://www.educo.edu/web/pubs/review/reviewArticles/30132.html

Copyright and Multimedia Law for Webbuilders and Multimedia Authors
http://www.lib.uiowa.edu/proj/webbuilder/copyright.html

The Copyright Clearance Center
http://www.copyright.com/
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multimedia document ever seen — check with your local DTIC library to

find out what the status is regarding acceptance of files. Whatever the
acceptable local standard is for submittal, you must comply. Given the explosion
of new technology, DTIC will be altering their submission standards to
accommodate these new formats.

F irst and foremost, before you begin developing the most incredible

‘While everyone may be submitting a different document type, there are some very
basic considerations and standards for all file types.

Decide on the Best Option for Submittal

If your document was created with a traditional publishing package like Word
Perfect or Word, or PowerPoint, you should consider submitting your document in
Acrobat format. It is multi-platform ready and can easily be added to Web sites for
dissemination. In addition, you can be assured that the file will print accurately not
matter where it is printed.

Collecting the Files and Programs

In some cases you may be linking from within one application to another. This is
the case with Acrobat and movie files. It is very important that whatever
application you choose to use, make sure the external files are in a relative location
to the core document.

A first step in making sure you won’t forget anything is to maintain a list of all the
files and applications necessary to experience your document. It is easier to start
this list online during the beginning of your project and just add to it along the way.
Make sure that you note the file name, type and application necessary for viewing
it. Don’t forget to identify the specific version of the software either. Software
changes frequently these days and you want to alleviate any frustration that your
audience may feel.

This list will eventually turn into a “read me” document that you will submit along
with the full project. Make sure you include any specialty software that your
project needs (within the bounds of the license agreement). Many software
packages have freely available viewers for their specific file format. Adobe has an
Acrobat viewer for PCs, Macs, and Unix machines. There are also Word and
PowerPoint viewers, although these are limited in the available platforms. You
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may want to choose Acrobat as the submittal format because it is so portable
across platforms and lives equally well on the Web and CD.

Transmitting the Document Project to DTIC

Contacting DTIC

Well, if you’ve added 4 sound clips, 3 movies and lots of photographs to your
document, you will see that the file size grows dramatically!. You have various
options for submittal, but both center around creating a single executable for the
submittal process. First, of course, you must make sure that you have all the files
(including the read me file).

You can create a ZIP file (compressed file) and then ftp (file transfer protocol) the
file to your appropriate submittal point, or you can create a self-extracting
executable. In some cases, your application will necessitate your submittal of it on
CD (Compact Disc). If this is the case, clear it first with your local librarian.

Remember, there are specific ways of creating a CD that enable its use on multiple
platforms. Check with your local technical support team for assistance on this
matter.

DTIC Web Page: http://www.dtic.mil/
E-mail help: help @dtic.mil
Help Line: 1-800-CAL-DTIC (225) 3842
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APPENDIX

extensions. The second lists Freeware and Shareware that can be used with

T his Appendix includes two parts. The first gives definitions of common file

many of these file types.

DEFINITIONS OF EXTENSION
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The following chart contains a list of common file name extensions and a brief
description of their format or purpose. Also included are some programs that can
be used to open these files for both the Macintosh and Windows platforms. The
section following this chart gives a brief description of the programs listed with
URL links to sites the programs can be downloaded from.

If you are viewing this document in PDF format, simply click on the program
name (highlighted in blue) to jump to that programs description and URL link.

.File Suffix Format Description & Type Some Programs that can be used
Macintosh: Adobe Illustrator
.ai Adobe lustrator Artwork
Windows: Adobe Illustrator
o . Macintosh: Use Sound Player to play it.
iff .aiff is a semi-common sound format. -
- Binary Windows: Use Waveform Hold and Modify
to play it
au is the most common sound format found |[Macintosh: Use Sound Player to play it.
-au on the web. ‘Windows: Use Waveform Hold and Modify
Binary :
to play it
.avi Movie Clip (AVI)
Windows: MS Win95 (RUNDLL32)
Macintosh: Use Stuffit Expander to turn
. Macbinary I Encoded File. Make sure to back into a usable Macintosh file if it isn't
.bin p ‘R: already.
download as MacBinary or Binary. Y
Windows: N/A
) Macintosh:
.bmp Bitmap Image
Windows: MS Paint, Photoshop, etc.
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.File Suffix Format Description & Type Some Programs that can be used
May be a DOS/Windows program or a Macintosh: Use MS-Word
.doc DOS/Windows Self Extracting Archive Use WordView to quickly display MS-Word
Binary documents
Macintosh: N/A
May be a DOS/Windows program or a Windows: Download and launch it in its
exe DOS/Windows Self Extracting Archive own temporary directory, it may spawn a
Binary number of files and directories. Self
Extracting
Macintosh: Use GIFConverter or JPEGView
GIF (Graphical Interchange Format), though - -
if not the most economical, is the most Windows: Use Lview Pro or PolyView to
£ common graphics format found on the view these graphics. Also paint programs
Internet. such as Adobe Photoshop, Paint Shop Pro,
MS Paint.
.gz is the Gnu version of zip. It is a Ma}cl:iintosh: Use macgzip to view and extract
- compression method developed for use on ~ |2rCAIVES.
‘ UNIX systems. Windows: Use WinZIP view and extract
Binary archives.
Macintosh: Use Netscape for Macintosh to
.html HTML (Hypertext Markup Language), the VW the file
htm code the web is written in. Plain text file. Windows: Use Netscape for Windows95 and
Windows NT to view the file
BinHex 4.0 - Encodes a Macintosh file into [ Macintosh: Use Stuffit Expander
Jhagx 7-bit text so it can be safely transferred. Windows: Use BinHex 13 in 2 DOS window
Most Mac files appear in .hgx to un-binhex it
. . Macintosh: Use ShrinkWrap to mount the
Macintosh Disk Image, most commonly disk image, and deal with it like you would a
.image found on Apple's FTP sites. floppy
Binary
Windows: N/A
Macintosh: Use JPEGView
JPE JPEG/3FIF, a 24 bit graphic format Windows: Use Lview Pro or PolyView to
Jpeg Binary view these graphics. Also paint programs
Jif such as Adobe Photoshop, Paint Shop Pro,
MS Paint.
Macintosh:
dll Dynamic Link Library

Windows: Comes with or added to the
operating system.
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.File Suffix Format Description & Type Some Programs that can be used
i Macintosh:
.mu.i MIDI Sequence ‘ :
rmi Windows: MS Win95 (RUNDLL32)
. Macintosh: Use Sparkle to play them, or to
.mpg MPEG, the standard movie platform for the |convert them to QuickTime.
'net.
-mpeg Binary Windows: Use NET TOOB or Ladybug to
play MPEGs
Macintosh: Use Sparkle, FastPlayer,
mov MoviePlayer, SimpleText,
t QuickTime Movie, Apple Macintosh native M1crpsoftWord...and many others. If the
-q ; movie appears totally white, you may need
. movie platform It
.movie Binary to use the Apple Quicktime VR Player to see
.Inoov them.
Windows: Use QuickTime for Windows
Macintosh:
pex PCX Image Document
Windows: Microsoft Paint
Macintosh: Use Adobe Acrobat Reader or
pdf Adobe Acrobat Portable Document Format, Adobe Acrobat Exchange
download as Binary Windows: Use Adobe Acrobat Reader or
Adobe Acrobat Exchange
Macintosh: Send to a Postscipt printer with
. . Laserwriter Font Utility or view it on-screen
s Postscript file. Plain text file, but not really  |using Ghostscript
P human-readable.
Windows: View it onscreen using
Ghostscript
Macintosh: Adobe Photoshop
.psd Adobe Photoshop Image -
Windows: Adobe Photoshop
Macintosh: Use Sparkle, FastPlayer,
MpviePlayer, SimpleText,
QuickTime Movie, Apple Macintosh native MicrosoftWord...and many others. If the
qt movie platform movie appears totally white, you may need
Binary to use the Apple Quicktime VR Playerto see
them.
Windows: Use QuickTime for Windows
. Real Audio File
ram

Windows: Real Audio Player
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.File Suffix Format Description & Type Some Programs that can be used
Macintosh: Download as MacBinary, and
sit Stuffit Archive - Binary use Stuffit Expander
Windows: Use UnSit in a DOS window
Macintosh: Download as MacBinary, and
.sea Macintosh Self Extracting Archive launch it. Self Extracting
‘Windows: N/A
UNIX tar program takes separate files and | Macintosh: Download and use Tar
turns them into one file. Often also
compressed. Extensions such .tar.Z, .tar.gz
and .tgz (latter two are equivalent) requires ) . .
-tar decompression first, then un-tar. Some Wlnfiows: Use WinZIP to view and extract
UNIX ftp servers will un-tar a file if you archives.
request it without the ".tar" extension.
Binary
Macintosh: Use JPEGView
Liff TIFF is a very large high quality image Windows: Use Lview Pro or PolyView to
tf format. view these graphics. Also paint programs
Binary such as Adobe Photoshop, Paint Shop Pro,
MS Paint.
Macintosh: Use Microsoft Word, Simple
_ ] Text, BBEdit, whatever!
Axt A plain boring old Text File .
Windows: Use the 16 or 32 bit version of
Programmer's File Editor
A uuencoded file. Macintosh: Use UU Undo to uudecode it
Typically this is done on a UNIX command
line: uuencode OriginalFileName
SecondFilename > EncodedFile.uu Then,
after running: uudecode EncodedFile.uu
-uu One gets a file generated named: ) .
.uue SecondFileName Using .uu as the extension |Windows: Use WinCode or ESS-Code to
is not required but is considered politely uudecode it
explanatory for what type of file it is.
Increasing numbers of desktop mail and
newsreading programs will handle this type
of encoding on the fly.
.vdo VDOLive Script

‘Windows: Video Live 32
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Some Programs that can be used

.File Suffix Format Description & Type
Macintosh: You can use SoundApp to play
way Windows Wave format sound file -wav files
Binary Windows: Use Waveform Hold and Modify
to play it
Macintosh: If you are downloading via ftp
most ftp servers will uncompress for you if
Unix Compressed File you drop the ".Z". Otherwise use Stuffit
.z Binary Expander w/EE.
Windows: Use WinZIP to view and extract
archives.
. . Macintosh: Use Ziplt, Stuffit Expander w/
pkzip, a common DOS/Windows EE, or MacUnZip
.zip compression format . -
Binary Windows: Use WinZIP to view and extract

archives.
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FREEWARE AND SHAREWARE
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This section lists a variety of useful software programs that are available for

download off the Web. Most are Freeware or Shareware.

Adobe Acrobat Reader

BinHex13

ESS-Code

Ghostscript

Freeware program from Adobe to read Adobe Acrobat Portable Document Format
files.

Source site: http://www.adobe.com/Software/Acrobat/

Use this in a DOS window to get the original file.
ftp://oak.oakland.edu/pub/simtelnet/msdos/mcintosh/
http://bang.lanl.gov/win/

http://www.cyf-kr.edu.pl/mirr-html/simtel/simtel_mcintosh.html

A Windows 32 bit program. Allows drag and drop uuencoding/decoding and
MIME support. Look for tile name like ecdXXw95.zip where XX is a version
number

http://www.geocities.com/CapitolHill/2171/
ftp://ftp.cica.indiana.edu/pub/pc/win95/txtutil/

Freeware program for viewing Postscript files on screen, saving to PICT format,
etc. The program requires that you install a large (~6 MB) collection of files
though. It also crashes a lot.

Macintosh source site:
http://www.glyphic.com/glyphic/projects/macgs.html

To run Aladdin Ghostscript on a PC you need gs###ini.zip, gs###fnl.zip and one
of gs#itdos.zip, gs#ititos2.zip, gs#it#win.zip or gs###w32.zip. Be sure to read the
README and Index files in this directory.

ftp://ftp.cs.wisc.edu/ghost/aladdin/
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GIFBuilder

GIFConverter

JPEGView

Ladybug
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For Mac users. This is a freeware program.
http:/fiawww.epfl.ch/Staff/Yves.Piguet/clip2Gif-home/GifBuilder.html

Shareware program (~$30) for viewing and converting between GIF, PICT, TIFF,
RLE, JPEG (JFIF), EPSE, RIFF, Macpaint, StartupScreen and "Scan Image"”
formats. Some primitive file editing can be done such as cropping and re-sizing
(scale-by-percent) and adjusting file resolution and dither pattern. GIFConverter
will save GIFs in Interlaced format if you choose, but cannot handle transparent
colors.

The main site:
http://www.kamit.com/gifconverter.html

Alternate:
http://www.macworld.com/cgi-bin/software.pl/Graphics/Software.32.html

JPEGView is a freeware graphic program to read GIF, JPEG, TIFF, and PICT files.
Runs fast and will dither nicely to any size of screen/color palette.

Source Site:
http://www.macworld.com/software/Software.832.html

Via FTP:
ftp://wuarchive.wustl.edu:/systems/mac/umich.edu/powermac

The Ladybug 1.00 for Windows95 can only play MPEG files less than 800KB but
it looks promising, watch for updates.

http://www.alberts.com:808 1/AuthorPages/00013277/Prod_170.htm

Laserwriter Font Utility

This comes with your Macintosh. It's on the Printing Tools disk, or it may already
be installed in your Utilities folder. If you need to download it from Apple, you
can.

Source site: http://www.support.apple.com/
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Lview Pro

Netscape

NET TOOB

PolyView
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Lviewpro provides support for a variety of graphics formats including GIF '89
(transparent backgrounds), conversion between different formats and image
editing functions.

Pick it up at
http://www.lview.com/

http://www.geocities.com/CapitolHill/2171/

Netscape is a very fast and powerful World Wide Web browser.

http://home.mcom.com/comprod/mirror/index.html

NET TOOB can play MPEG system layer streams containing both video and audio
for Windows 3.x, Windows 95/98/NT and Macintosh.

http://www.bitcasting.com/d]_nt.html

PolyView is a Windows NT/95/98 program that displays GIF, JPEG, TIFE, and
photo-cd graphics files and converts between these file formats.

http://www.polyview.com/

Programmer's File Editor

QuickTime

Quicktime VR Player

Programmer's File Editor is a large-capacity multi-file programming oriented
editor for Windows 3.1x, Windows NT on Intel and PowerPC platforms, and
‘Windows 95.

Get the 32 bit version (pfeXXXXX.zip) at
http://32bit.bhs.com/default.asp

QuickTime is Apple's video format. Players for Macintosh and Windows are
available.

http://www.apple.com/quicktime/

This is a QuickTime movie player that will also play QuickTime VR movies
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Source Site:
http://www.apple.com/quicktime/qtvr/index.html

http://www.realaudio.com/

Shrinkwrap is a free Mac utility that allows you to mount and use disk image files
as if they were a mounted floppy disk. You can also copy disk images to floppies
with Shrinkwrap by simply dragging the floppy icon onto Shrinkwrap.

http://wwwhost.ots.utexas.edu/mac/pub-mac-compression.html#shrinkwrap-142

Sound Player is a multipurpose sound program that can record and play back .au
and aiff format sounds.

Source Site:
http://wwwhost.ots.utexas.edu/mac/pub-mac-sound.html

Alternative Sites:
http://fwww-cs-students.stanford.edu/~franke/Sound App/#abou

http://www.syntrillium.com/cep/proinfo.htm

http://www.quadmation.com/pphome.htm

SoundApp is a small featureless program that will play most audio files you may
find

http://wwwhost.ots.utexas.edu/mac/pub-mac-sound.html

Sparkle is the best MPEG player for the mac. You can play and convert between
Quicktime and MPEG.

Source Site:
http://ccsmacinfo.ccs.queensu.ca/MacSDistribution/Sparkle.html

Or try
http://teachnet.edb.utexas.edu/Conferences/TeachNet%20File%20Area/Pop%20M
ac%?20Software/%231606061
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Stuffit Expander with Expander Enhancer

Tar

UNSIT

UU Undo

Stuffit Expander is the decompression program for the mac. With Expander
Enhancer (It is installed when you install DropStuff) you can expand a LOT of
formats!

get both Stuff Expander and Drop Stuff w/ EE from Aladdin at
http://www.aladdinsys.com

Tar 4.0 will read and write tar files.

gopher://gopher.archive.umich.edu:7055/40/mac/util/compression/tar4.0b.sit.hgx

UNSIT is a simple utility for PC users to extract files from a StuffTt file.
ftp://ftp.cdrom.com/pub/simtelnet/msdos/mcintosh/unsit30.zip

UU Undo is a simple program to decode uu encoded files on the mac.

http://tucows.bealenet.com/mac/compmac.html

Waveform Hold and Modify (WHAM)

WinCode

WinZip

WHAM provides support for a variety of formats, conversion between them and
file editing functions.

Pick it up from
http://tucows.bealenet.com/softsoun.html

Wincode is a Windows 3.x program which converts 8-bit BINARY (EXE,
COM,GTF, etc.) files to 7-bit ASCII (Text) files (and vice versa) through a process
known as bit-shifting. Wincode currently supports UU/XX and Base64 (MIME 1.0
conformant) coding.

To be had from
http://www.winsite.com/info/pc/win3/util/wincode.zip/

WinZip is an essential tool for it's excellent handling of many different archiving
and compression formats. Downloads asa self-extracting archive.
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Get the 16 or 32 bit version (wzntXX.exe) at
http://www.winzip.com/info.htm

For MS-Windows users, displaying Microsoft Word documents without having to
allocate the memory resources required to fire up MS-Word is very handy. Get

yours at
ftp://ftp.microsoft.com/Softlib/MSLFILES/

A fast program for the Macintosh to extract and create Zip archives.

Home Site:
http://www.awa.com/softlock/zipit/zipit.html
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3D

Animated GIF

Applet

GLOSSARY

With these programs, you take a simple shape and stretch, bend & twist them into
3D models. You can create anything from a rotating square to a realistic dinosaur
for a movie with this type of program. Some examples of 3d programs are
Macromedia Extreme 3D, 3D Studio Max and Lightwave.

An animated GIF is a graphic image on a Web page that moves - for example, a
twirling icon or a banner with a hand that waves or letters that magically get larger.
In particular, an animated GIF is a file in the Graphics Interchange Format
specified as GIF89a that contains within the single file a set of images that are
presented in a specified order. An animated GIF can loop endlessly (and it appears
as though your document never finishes arriving) or it can present one or a few
sequences and then stop the animation.

GIFBuilder, a freeware program for Mac user can be found at:
http://fiawww.epfl.ch/Staff/Y ves.Piguet/clip2Gif-home/GifBuilder.html

GIF Construction Set, a shareware program for Windows users from Alchemy
Mindworks, can be found at:
http://www.mindworkshop.com/alchemy/gifcon.html

A number of people maintain lists of animated GIF examples. The Dutchman's
Page, http://www.vuurwerk.nl/levon/animated.html, includes a "Top 150 Animated
GIFs List." Learn2.com, http://www.learn2.com, is a site that makes intelligent,
selective use of animated GIFs to illustrate "how-to" topics.

On the Web, the term is often "Java applet.” But applets existed before the Java
programming language arrived. They're simply "little application programs” that
are usually built into an operating system or a larger application program. The
built-in writing and drawing programs that come with Windows are sometimes
called "applets.”
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With Java, which is a language designed for creating small program objects for a
distributed environment like the Web, an applet becomes something that can arrive
along with an HTML file. A user can then click on an image and trigger the applet
to animate the image or cause a popup window to appear and ask a question, then
perform some calculation tailored to the user's input.

AVl
Audio/visual interface. Windows AVI provides the capability to develop animation
files that can be included in multimedia presentations and as part of World Wide
Web pages. The files (which end with an .avi extension) require a special player
which may be already included with your Web browser or may require
downloading.

BMP
In a bitmapped graphics file, the color of each pixel is described with one or more
bits of information. The number of bits used to record the information for one pixel
is called the bit depth of the file.

Since a bit of information can describe only one of two values (0 for off, or 1 for
on), a pixel described by one bit can only be either black or white. 8-bit would
describe a pixel of one of 256 shades of gray or color (2%). 24-bit would describe a
pixel capable of displaying one of over 16.7 million colors (2%%. See also Raster
graphics.

Browser
A browser is a program that provides a way to look at, read, and even hear all the

information on the World Wide Web. The word "browser" seems to have originated
prior to the Web as a generic term for user interfaces that let you browse text files
online. By the time the first Web browser with a graphical user interface was
invented (it was called Mosaic), the term seemed to apply to Web content, too.
Technically, a Web browser is a client program that uses the Hypertext Transfer
Protocol (HTTP) to make requests of Web servers throughout the Internet on
behalf of the browser user. Currently, the most popular browser is Netscape
Navigator. Microsoft's Internet Explorer is gaining usage as Windows 95
installations grow. A commercial version of the original browser, Mosaic, is in use.
Other browsers include the browsers for the online services, America Online,
Compuserve, and Prodigy, but these are beginning to offer Netscape or Internet
Explorer in addition to or as a replacement for their own. Lynx is a text-only
browser for UNIX shell and VMS users.
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BrowserWatch http://browserwatch.internet.com/ is an extremely informative site
which enables users to download various browsers, plug-ins and ActiveX controls
for all platforms including Macintosh, OS/2, Unix, and Windows.

Used for monochrome images, all types of CCITT compression are lossless.

CCITT Group 3 compresses monochrome bitmaps one row at a time (the method
used by most fax machines).

CCITT Group 4 is a general-purpose method that produces good results for most
types of monochrome images.

Computer Graphics Metafile. CGM is oriented toward stroke drawn graphics, but
includes raster bitmap encoding.

Client/server describes the relationship between two computer programs in which
one program, the client, makes a service request from another program, the server,
which fulfills the request.

Desktop Color Separation-5 (DCS-5) files are EPSF files that contain separated
color information for images (cyan, magenta, yellow, black and a low-resolution
preview file). They are most commonly used with QuarkXPress. Placed EPSF files
of this type will not produce good-quality PDF files, because only the low-
resolution preview file is written into the PostScript language file and appears in
the PDF file.

Dithering is the attempt by a computer program to approximate a color from a
mixture of other colors when the required color is not available. Typically,
dithering occurs when a color is specified for a Web page that a browser on an
operating system can't support. The browser will then attempt to replace the
requested color with an approximation composed of two or more other colors it
can produce. The result may or may not be acceptable to the graphic designer. It
may also appear somewhat grainy since it's composed of different pixel intensities
rather than a single intensity over the colored space.
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To understand the colors available with Web browsers, see the 216-color browser
safe palette colors and values at whatis.com’s web site at
http://whatis.com/216color.htm.

Dynamic link library. In personal computers, a DLL file is a modular program
routine that comes with or can be added to your operating system. Each DLL file
must have a ".dll" file name extension. DLL files are dynamically linked with the
program that uses them during program execution. They don't need to be compiled
with the main program. The set of such files (or the DLL) is somewhat comparable
to the library routines provided with programming languages such as C and C++.

Digital versatile disk (DVD), a new optical disk technology that is expected to
rapidly replace the CD-ROM disk over the next few years. The digital versatile
disk (DVD) holds 4.7 gigabytes of information on one of its two sides, or enough
for a 133-minute movie. With two layers on each of its two sides, it will hold up to
17 gigabytes of video, audio, or other information. (The current CD-ROM disk of
the same physical size, holds 600 megabytes. The DVD can hold more than 28
times as much information!)

The DVD player will also play regular CD-ROM disks. DVDs can be recorded in
any of three formats, variously optimized for: video (for example, continuous
movies) audio (for example, long-playing music), or a mixture (for example,
interactive multimedia presentations).

Encapsulated PostScript is a PostScript language file with a “blanket” wrapped
around it to make it understandable to applications. EPSF files sometimes include
a preview image, which can be color or black and white. These preview images are
platform specific; Windows uses the metafile format and the Macintosh uses the
PICT format.

Freeware is programming that is offered at no cost. However, it is copyrighted so
that you can't incorporate its programming into anything you may be developing.
The least restrictive "no-cost" programs are uncopyrighted programs in the public
domain. These include a number of small UNIX programs. When reusing public
domain software in your own programs, it's good to know the history of the
program so that you can be sure it really is in the public domain.
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Graphics Interchange Format is an 8-bit format used for Macintosh and PC raster
images on CompuServe and other online services. It offers small file sizes for
transmission efficiency, but limited color quality makes it unsuitable for most
publishing applications.

HTML (Hypertext Markup Language) is the set of "markup” symbols or codes
inserted in a file intended for display on a World Wide Web browser. The markup
tells the Web browser how to display a Web page's words and images for the user.

JPEG (Joint Photographic Expert’s Group) is lossy compression. JPEG
compression is a technique in which more-detailed parts of an image are
compressed less than are less-detailed parts of an image. JPEG compression
represents an attempt to reduce the size of an image with a minimum loss of
information. However, removal of information from the file reduces image quality.

Continuous-tone images, such as photographs, benefit most from JPEG
compression. JPEG compression takes bands or scan lines of the image and
compresses them one at a time. It does not determine areas of similar color and
compress area by area, as LZW does.

Liteware is a term for software that is distributed freely in a version having less
capability than the full for-sale version. It's usually designed to provide a potential
customer with a sample of the "look-and-feel" of a product and a subset of its full
capability. Liteware can be considered a type of shareware (where shareware also
includes products distributed freely, usually on a trial basis, that do have full
capability).

LZW (Lempel, Ziv, Welch) provides lossless compression. LZW compression
simply compresses data; no information is lost. On 8-bit and lower color resolution
files, LZW produces file compression. Generally, LZW compression on 24-bit
color images produces a larger, rather than smaller, file size. (Distiller’s AutoFilter
will automatically apply JPEG compression to 24-bit continuous-tone images,
even if you have specified LZW.)
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Screen shots or images that are mostly large blocks of the same color benefit most
from LZW compression. LZW compression takes areas of images that are the
same color and compresses them as one piece. Since photographs tend not to have
large areas of the same color value, LZW compression is not especially efficient
for them. :

Metafile

A metafile is a file containing information that describes or specifies another file.

Midi
Musical Instrument Digital Interface. MIDI is a protocol designed for recording
and playing back music on digital synthesizers that is supported by many makes of
personal computer sound cards. Originally intended to control one keyboard from
another, it was quickly adopted for the personal computer. Rather than
representing musical sound directly, it transmits information about how music is
produced. The command set includes note-ons, note-offs, key velocity, pitch bend
and other methods of controlling a synthesizer. The sound waves produced are
those already stored in a wavetable in the receiving instrument or sound card.

MIME
MIME (Multi-Purpose Internet Mail Extensions) is an extension of the original
Internet e-mail protocol that lets people use the protocol to exchange different
kinds of data files on the Internet: audio, video, images, application programs, and
other kinds, as well as the ASCII handled in the original protocol, the Simple Mail
Transport Protocol (SMTP).

MPEG
MPEG (pronounced M-peg), which stands for Moving Picture Experts Group, is
the name of family of standards used for coding audio-visual information (e.g.,
movies, video, music) in a digital compressed format.

The major advantage of MPEG compared to other video and audio coding formats
is that MPEG files are much smaller for the same quality. This is because MPEG
uses very sophisticated compression techniques.

PICT
Apple’s file format for display of 72-dpi bitmapped graphics. PICT data is one
element of high-resolution EPS files, enabling the PostScript image to be
displayed on screen.
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PNG (pronounced PING) is a file format for compressed graphic images that, in
time, is expected to replace the GIF format that is widely used on today's Internet.
The GIF format, patented by Compuserve (which is now owned by America
Online), and its usage in image-handling software involves licensing or other legal
considerations. (Web users can make, view, and send GIF files freely but they can't
develop software that builds them without an arrangement with Compuserve.) A
PNG file, on the other hand, was developed by an Internet committee expressly to
be patent-free. It also provides a number of improvements over the GIF format.

Like a GIF, a PNG file is compressed in lossless fashion (meaning all image
information is restored when the file is decompressed during viewing). A PNG file
is not intended to replace the JPEG format, which is "lossy" but lets the user make
a trade-off between compression and quality when the image is restored. Ideally,
an image in a PNG file can be 10 to 30% more compressed than in a GIF format.

Public Domain software

Raster

RGB

Programs that are uncopyrighted because their authors intended to share them with
everyone else are in the public domain. The UNIX community has developed a
number of such programs over the years. Programs in the public domain can be
used without restriction as components of other programs. When reusing such
code, it is good to understand its history so that you can be sure it really is in the
public domain.

Raster (or pixel based) programs describe shapes as a pattern of dots or pixels.
With these programs you can edit scanned images or create your own images.
Images on the web (.gif & .jpg) are this type of image. Each image is made up of
tiny squares of color called pixels. Each pixel has only one color and it is made up
of an RGB (Red, Green, Blue) value. Once all these colored pixels are side by side,
they form an image. Some examples of Raster paint programs are Adobe
Photoshop, Paint Shop Pro, Macromedia X-Res, Fractal Design Painter, and L-
View.

RGB is an image file format in which each pixel is a combination of Red, Green,

. and Blue. This means that a color map is not required to reproduce the image.
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Run Length is a lossless compression method. Run Length produces the best
compression for images that contain large areas of solid white or black. (Not good
if there are too many changes in black & white, for example a checkerboard would
actually create a larger file.) A good example of an image that would benefit from
Run Length compression: Yin/Yang symbol.

Y

Shareware is software that is distributed free on a trial basis with the understanding
that the user may need or want to pay for it later. Some software developers offer a
shareware version of their program with a built-in expiration date (after 30 days,
the user can no longer get access to the program). Other shareware (sometimes
called liteware) is offered with certain capabilities disabled as an enticement to buy
the complete version of the program.

You can find a great deal of shareware and freeware at http://www.shareware.com.

Tagged Image File Format enables high-resolution bitmapped graphics to be
displayed, edited and output by applications and most operating systems. The TIFF
format is used for storing black and white, grayscale, or color bitmap images.

TIFF image data typically comes from scanners, frame grabbers, and paint- and
photo-retouching programs. Its purpose is to describe and store raster images. The
primary reason for TIFF is to provide a rich environment within which
applications can exchange data. This richness is required to take advantage of
varying capabilities of scanners and other imaging devices that are available. TIFF
images are made up of four baseline types: bi-level, grayscale, palette-color, and
RGB full-color images. It is not used for storing text or draw-type graphics. TIFF
also allows for a unlimited amount of private or special-purpose information to be
added to a fill.

TIFF is hardware and software independent. TIFF is not tied to any specific
scanner, printer, or display hardware. It is also portable, since it does not favor
particular operating systems, file systems, compilers, or processors (this is
common of most widely used file formats).
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TIFF provides several different compression schemes that allow you to trade-off
size and quality to archive a file that is of best use to you. These compression
schemes include JPEG, LZW, Huffman, and packbits compression. The
compression schemes help to shorten file transfer time but the decoding of a TIFF
file takes longer then other available file formats. TIFF files are best used for
scanning images

A URL (Uniform Resource Locator) is the address of a file (resource) accessible
on the Internet.

Vector programs use mathematical calculations to draw the shapes. Layering these
shapes gives the appearance of an image. These programs rely on a language (for
example, Postscript) to describe how to draw a graphic. Vector programs are
generally used for creating original artwork, logos or special text effects that you
can’t create with Raster (pixel based) programs. Once you create an image in a
vector program, you usually import it into a Raster Paint program to add more
color or depth to the image. With vector programs, you can’t save as a .gif or .jpg
image. They each have their own special format that saves your image in layers.
Some examples of vector programs are Adobe Illustrator, Corel Draw, and
Macromedia Freehand.

The format for storing sound in files developed jointly by Microsoft and IBM.
Support for WAV files was built into Windows 95 making it the de facto standard for
sound on PCs. WAV sound files end with a .wav extension and can be played by
nearly all Windows applications that support sound.

The PC-based counterpart to PICT. Windows Metafile Format is a standard default
format used by PC clipboards if images are cut, copied, and pasted between
applications.
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3D Modeling

Audio

Cool Stuff

Graphics

URL SOURCE FILES

In addition to the many that are already found throughout the text.

The ultimate 3D modeling and animation site of Pixar
http://www.pixar.com)

An eclectic sight of both comic and serious audio clips can be found at:
http://dailywav.com

One of the great sites of all time, existed before the WWW (in the days of
gopher!).
http://sunsite.unc.edu/

A terrific service by the folks at Lawrence Livermore Labs is a WWW Viewer Test
Page. On this page they have compiled all the data types with a test button. When
the test is selected, the Web server sends back data of the selected type. This is
extremely useful for checking the functionality of a Web browser and its operating
environment.

http://www-dsed.llnl. gov/documents/WWWtest.html

WWW Browser Test Document
http://wwwedu.ssc.nasa.gov/htmls/wwwbrow.htm

Page on Silicon Graphics Web site that links to all SGI products regarding
multimedia.
http://www.sgi.com/software/software html#media

Various links to sources for icons, jpegs, and other graphics.
http://www.stars.com/V1ib/Providers/Images_and_Icons.html

Silicon Graphics Web site with lots of interesting images!
http://www.sgi.com/Fun/free/gallery.html
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Eastman Kodak Co.’s Web page includes links to a wide variety of photographic
topics.
http://www.kodak.com/

Fractal Design Corp.’s site includes galleries of artwork (most created with Fractal
Design products, of course) that you can view and use as a source of graphical
ideas.

http://www.fractal.com/

Yahoo's extensive Photography master page includes roughly 20 photo-related
categories, including galleries, exhibits, museums, photographers and stock
photography companies. You’ll find hundreds of links to interesting photos, clip
art, utilities, and other exciting graphics on the Web.
http://yahoo.com/arts/photography/

With West Stock Inc.’s Muse service, you can view thumbnails of more than 5,000
offerings, select and download images, and pay for your purchases 24 hours a day,
all without leaving the comfort of your browser.

http://www.weststock.com/

PhotoDisc Inc., a publisher of CD-ROM image collections, provides an online
service tapping its library of more than 10,000 images.
http://www.photodisc.com :

Cloud Gallery has 32 fine-art photos of clouds and other scenery that you can
incorporate into your own pages.
http://www.commerce.digital.com/palo-alto/CloudGallery/home.html

You can preview stock photography portfolios that are updated monthly and
include a broad range of subjects, including people, multimedia, and backgrounds,
for several top shooters at

http://www.indexstock.com/pages/profile.htm

Liaison International Inc. posts 1,400 of the best of its 4 million images at
http://www.liaisonint]l.com/

One Mile Up, Inc. is the creator, designer and manufacturer of the Federal Clip
Art Libraries. Federal Clip Art is electronic artwork illustrated on a computer by
expertly trained artists for use by desktop publishers competing in the federal
arena. It has 14 collections of over 7,800 computer illustrations hand-drawn to
government specifications. Topics range from military insignia and combat art to
foreign and domestic maps, flags and coats of arms.

http://www.onemileup.com/
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Map Art contains beautifully rendered and accurate World maps, globes and US
State Terrain maps to integrate into your multimedia or print design.
http://www.map-art.com/

Multimedia Project Gallery contains links to some video clips and still photos of
various experiments and projects, grouped by ship/project type.
http://www50.dt.navy.mil/gallery/

Science & Engineering

Software

Space

Frank Potter's Science Gems — Engineering related sites (over 200). Lots of
fascinating information, geared towards educational/research topics.
http://www-sci.lib.uci.edu/SEP/engineerhtml

One of the best sites for downloading Shareware and Freeware programs. Gives
programs ratings (from one to five cows).
http://www.tucows.com

Another source of software on the Web. Software is categorized by type and is
available for download. Indicated on type of software: freeware, shareware or
cost. Links to the home pages and to directly download the software are available.
http://www.download.com

Software Distribution, Macintosh Computers
http://ccsmacinfo.ccs.queensu.ca/MacSDistribution/Mac_soft.html

Goddard Space Flight Center links to graphics, movies and satellite information.
http://pao.gsfc.nasa.gov/gsfc/gallery/index.html

Links to graphics, movies and low, medium and high resolution graphics of the
Space Station.

http://station.nasa.gov/core.html

http://station.nasa.gov/gallery/index.html

http://207.86.88.39/news/photos/artistic.html

Digital Library at Ames Research Center. Includes samples in the Aeronautical,
Life Sciences, Astrobiology, Earth Sciences and Space area.
http://ails.arc.nasa.gov/digital 1.html
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VRML
The VRML Repository is an impartial, comprehensive, community resource for
the dissemination of information relating to VRML. Maintained by the San Diego
Supercomputer Center (SDSC).
http://www.sdsc.edu/vrml

Web Development
“The Web Developer’s Virtual Library” All around great educational site to teach
yourself about the current and up-and-coming web development technologies. Not
affiliated with any software manufacturer.
http://www.stars.com

C-4 Publishing with Multimedia




MULTIMEDIA RESOURCES

preaR R ERENROR NN NN ERERBRNRERIERONOERRONDEROE RO RO
This features table contains a list of companies that offer the multimedia products
indicated by the chart. Visit them at the sites listed for more details and to see what

other products and services are available.
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Allegro New Media www.businessplus.com v
Amug CD Inc. www.amug.com v v
Aridi Computer Graphics Inc. www.aridi.com
Artbeats Software Inc. www.artbeats.com v v v v
Aware Inc. www.aware.com v
Aztech New Media Corp. www.aztech.com v v
BeachWare www.beachware.com v v v v v
Bright Ideas www.dtp-ideas.com v
Corel Corp. www.corel.com v v
D’Pix of Amber Productions www.monotype.com v
Davika Corp. www.davka.com v
Digital Stock Corp. www.digitalstock.com v
Educorp www.educorp.com v v | V| /
The Hollywood Film Music Library www.firstcom.com v
Image Club Graphics www.imageclub.com |/
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Image Farm Inc. www.imagefarm.com v
Imagetects www.imagecels.com v
IMSI www.imsisoft.com AN AN A B A 4
Letraset www.letraset.com v/ | v/
Media In Motion www.mmotion.com |/
Mediacom Inc. www.mediacominc.com v
The Music Bakery www.musicbakery.com v
Olduvai Corp www.olduvai.com v v
Pacific HiTech Inc. www.pht.com v
PhotoDisc Inc. www.photodisc.com v v
PhotoSphere Images www.photosphere.com v
Rocky Mountain Digital Peeks www.sni.net/malls/rmdp v
RomTech www.romtech.com v v
Seattle Support Group WWW.SSZIp.com v
Sense Interactive Corp. www.mediaplace.com/sense v
Showker Graphic Arts www.graphic-design.com v |/
T/Maker Co. www.clickart.com v
Totem Graphics Inc. www.gototem.com |/
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TOTO Computer Graphics Inc www.toto-cgi.com v
VCE www.vce.com v v
Vivid Details www.vividdetails.com e
Xaos Tools Inc. www.xaostools.com e
Zedcor Inc. www.arttoday.com v
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APPENDIX

ADOBE PRODUCT PRICE LIST

On GSA schedule GS-35F-4139D

INFODATA SYSTEMS INC.
703-218-1155

?qe;:: SIN 'n Ir::e Prrlt:?‘lo Product Description F?r?cAe Warr :gg:; Il:t:?:t
R T T T T T T T I N N I Y
Infodata 132-33 Adobe 16010011 2‘:‘;2:3}’,‘:;’:;‘/’12 V3.0 $10870 30days  yes US.
Infodata 132-33 Adobe 26010011 g‘:ﬁ‘;’n]);;“/;’ﬁgsfiiﬂ $10870 30days  yes US.
Infodata 13233 Adobe 16000146 g‘:ﬁ:gp‘ﬁ:ﬁ:'o $32499 30days  yes US.
Infodata 13233 Adobe 26000008 ?0‘:‘;3‘;’;191‘5’3/;?;‘1' N Z):)later $32499 30days  yes US.
Infodata 132-33 Adobe 16000152 }‘}fc‘;:’;]r]ﬁ;j;:w V;‘I&jc $1,299.98 30days  yes US.
Infodata 13233 Adobe 02600013 si‘f:of&i:a;gg;'gig e SU29998 30days  yes  US.
Infodata 132-33 Adobe 13110001 f‘z‘:‘gfwlfr‘;f:feady vio $16332 30days  yes US.
Infodata 132-33 Adobe 23110001 g‘:";’v‘;’nh;;g;?eady V10 $163.32 30days  yes US.
Infodata 132-33 Adobe 16020011 ﬁfﬁijgzﬁﬁif'o $108.70 30days  yes US.
Infodata 13233 Adobe 26020011 ﬁf‘{;‘;’ns;;,;“}““ v4.0 $10870 30days  yes US.
Infodata 13233 Adobe 07501030 ;i‘;;: Sls‘;t;a::; ?Of SUN §54348 30days  yes OO
Infodata 13233 Adobe 07501035 [A]:;b;ii‘;;ats‘;l? 33 $2,182.10 30days  yes US.
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Name SIN Name Part No Product Description Price Warr 2000 Point
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Adobe Illustrator v5.5 10

Infodata 132-33 Adobe (07501036 User Pack for SUN $3,820.72 30 days yes U.s.
Adobe IMlustrator v5.5

Infodata 132-33 Adobe 07501042 Documentation Only for SUN $81.93 30 days yes U.s.
Adobe Photoshop v3.0.1

Infodata 132-33 Adobe 07101036  Single User Pack - $543.48 30 days yes U.s.
Node Locked for SUN
Adobe Photoshop v3.0.1

Infodata 132-33  Adobe 07101029  Single User Pack - $1,035.06 30 days yes U.s.
Floating for SUN
Adobe Photoshop v3.0.15

Infodata 132-33 Adobe 07101026 User Pack for SUN $4,148.45 30 days yes USs.
Adobe Photoshop v3.0.1

Infodata 132-33 Adobe 07101031 Documentation Only for SUN $81.93 30 days yes Us.
Adobe Illustrator v5.5

Infodata 132-33 Adobe 06501023 Single User Pack for SGI $543.48 30 days yes uU.s.
Adobe [lustrator v5.5 5

Infodata 132-33 Adobe 06501024 User Pack for SGI $2,182.10 30 days yes U.s.
Adobe Iltustrator v5.5

Infodata 132-33 Adobe 06501012 10 User Pack for SGI $3,820.72 30 days yes U.Ss.
Adobe Nlustrator v5.5

Infodata 132-33 Adobe 06501025 Documentation Only for SGI $81.93 30 days yes us.
Adobe Photoshop v3.0.1

Infodata 132-33 Adobe 06101033  Single User Pack - $543.48 30 days yes Us.
Node Locked for SGI
Adobe Photoshop v3.0.1

Infodata 132-33 Adobe 06101026  Single User Pack- - $1,035.06 30 days yes U.s.
Floating for SGI
Adobe Photoshop v3.0.1

Infodata 132-33 Adobe 06101023 5 User Pack for SGI $4,148.45 30 days yes Us.
Adobe Photoshop v3.0.1

Infodata 132-33 Adobe 06101028 Documentation Only for SGI $81.93 30 days yes U.S.
Adobe PageMaker v6.0

Infodata 132-33 Adobe 27500001 $488.86 30 days yes U.s.

for Win 3.1/95
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Adobe PageMaker v6.52
Infodata 132-33 Adobe 17500186 for Mac/PowerMac $488.86 30 days yes U.sS.
Adobe PageMaker v6.52
Infodata 132-33 Adobe 27500155 for Win 95/NT $488.86 30 days yes U.S.
Adobe PageMaker v6.52
Infodata 132-33 Adobe 17500191 License Pack for Mac/PowerMac $391.08 30 days yes Us.
Adobe PageMaker v6.52
Infodata 132-33 Adobe 27500160 License Pack for Win 95/NT $391.08 30 days yes UsS.
Adobe PageMaker v6.52 5
Infodata 132-33 Adobe 17500189  User License Pack for $1,955.42 30 days yes U.s.
Mac/PowerMac
Adobe PageMaker v6.52 5
Infodata 132-33 Adobe 27500158 User License Pack for Win 95/NT $1,955.42 30 days yes Us.
Adobe PageMaker v6.52
Infodata 132-33 Adobe 01750590 FC for Mac/PowerMac $488.86 30 days yes U.Ss.
Adobe PageMaker v6.52
Infodata 132-33 Adobe 02750421 EC for Win 95/NT $488.86 30 days yes U.Ss.
Infodata 132-33 Adobe 27910016 “dobeFrameMakervs.1.1 $488.86 30days  ves  US.
for Windows 3.1
Adobe FrameMaker v5.1.1
Infodata 132-33 Adobe 27910004 for Win 95/NT 3.5 or later - $488.86 30 days yes Us.
Adobe FrameMaker v5.5
Infodata 132-33 Adobe 17910059 for Mac/PowerMac $488.86 30 days yes Us.
Adobe FrameMaker v5.5
Infodata 132-33 Adobe 27910081 for Win 95/NT $488.86 30 days yes UsS.
Adobe FrameMaker v5.5
Infodata 132-33 Adobe 37900224  Personal for UNIX - $816.58 30 days yes Us.
SUN, IBM, SGI & HP
Adobe FrameMaker v5.5
Infodata 132-33 Adobe 37900226  Shared for UNIX - $1,417.41 30 days yes Us.

SUN, IBM, SGI & HP

Infodata 13233 Adobe 2790424  ‘rdobeFrameViewervs.l.l $1584  30days  yes US.
for Windows 3.1
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Adobe FrameViewer v5.5

Infodata 132-33 Adobe 17930001 for Mac/PowerMac $15.84 30 days yes  US.
Adobe FrameViewer v5.5

Infodata 132-33 Adobe 27930001 for Win 95/NT $15.84 30 days yes U.Ss.
Adobe FrameViewer v5.5

Infodata 132-33 Adobe 37930001 for UNIX - $27.31 30 days yes u.s.
SUN, IBM, SGI & HP
Adobe FrameViewer

Infodata 132-33 Adobe 47930004  Retrieval Toolkitvs.5 $2,182.10 30 days yes Us.
for Mac/Win/UNIX
Adobe FrameMaker ’

Infodata 132-33 Adobe 02790001  v5.1.1+SGML $816.58 30 days yes US.
for Windows 3.1 or later
Adobe FrameMaker
v5.1.1+4SGML

Infodata 132-33 Adobe 08790001 Personal for UNIX - $1,089.68 30 days yes Us.
SUN, IBM, SGI & HP
Adobe FrameMaker
v5.1.1+4SGML

Infodata 132-33 Adobe 8790004 Shared for UNIX - $2,182.10 30 days yes U.s.

SUN, IBM, SGI & HP
Adobe FrameMaker v5.5+SGML

Infodata 132-33 Adobe 17920004 for Mac/PowerMac $1,089.68 30 days yes U.s.
Adobe FrameMaker v5.5+SGML

Infodata 132-33 Adobe 27920004 for Win 95/NT $1,089.68 30 days yes U.s.
Adobe FrameMaker v5.5+SGML

Infodata 132-33 Adobe 37920003  Personal for UNIX - $1,089.68 30 days yes Us.

SUN, IBM, SGI & HP

Adobe FrameMaker v5.5+SGML

Infodata 132-33 Adobe 37920007  Shared for UNIX - $2,182.10 30 days yes Us.
SUN, IBM, SGI & HP
Adobe FrameMaker v5.5+SGML

dat -
Infodata 132-33 Adobe 17920007 Migration for Mac/PowerMac $543.48 30 days yes UsS.

Adobe FrameMaker v5.5+SGML
Infodat 132-33 Adob 2792 . S.
odata 13 obe 920007 Migration for Win 95/NT $543.48 30 days yes US
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Adobe FrameMaker v5.5+SGML
Infodata 132-33 Adobe 27920006 Migration Personal for UNIX -  $543.48 30 days yes Us.
SUN, IBM, SGI & HP
Adobe FrameMaker v5.5+SGML
Infodata 132-33 Adobe 37920010 Migration Shared for UNIX - $816.58 30 days yes U.s.
SUN, IBM, SGI & HP
Adobe After Effects v3.1
Infodata 132-33 Adobe 25510001 for Win 95/NT $543.48 30 days yes USs.
Adobe After Effects v3.1
Infodata 132-33 Adobe 15510002  Production Bundle for $1,089.68 30 days yes UsS.
Mac/PowerMac
Adobe After Effects v3.1
Infodata 132-33 Adobe 25510005  Production Bundle for Win $1,089.68 30 days yes USs.
95/NT
Adobe After Effects v3.1
Infodata 132-33 Adobe 15510062  PB/Photoshop v4.0 for $1,362.79 30 days yes Us.
Mac/PowerMac
Adobe After Effects v3.1
Infodata 132-33 Adobe 25510024  PB/Photoshop v4.0 for Win $1,362.79 30 days yes U.s.
95/NT
Adobe After Effects v3.1
Infodata 132-33 Adobe 15510094  PB/Premiere v4.2 for $1,362.79 30 days yes Us.
Mac/PowerMac
Adobe After Effects v3.1
Infodata 132-33 Adobe 25510061 PB/Premicre v4.2 for Win 95/NT $1,362.79 30 days yes Us.
dob: i R
Infodata 132-33 Adobe 15500014 ‘-dobe Premierev3.0 $488.86 30days  yes U.S.
for PowerMac
Infodata 132-33 Adobe 35500001 Adobe Premierevd.2 $54348 30days yes US.
for SGI
Adobe Acrobat Capture v2.0.1
Infodata 132-33 Adobe 22101133 for Win 95/NT $488.86 30 days yes Us.
Adobe Premiere v5.0
Infodata 132-33 Adobe 25500014 for Win 95/NT 4.0 o later $488.86 30 days yes Us.
Adobe Acrobat Capture
Infodata 132-33 Adobe 22101104 20,000 Pack for Win 95/NT $324.99 30 days yes Us.
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Adobe Acrobat Capture
Infodata 132-33 Adobe 22101103 200,000 Pack for Win 95/NT $2,728.31 30 days yes U.S.
Adobe Acrobat v3.0.1
Infodata 132-33 Adobe 12001136 for Mac/PowerMac $161.13  30days yes U.s.
Infodata 132-33 Adobe 22001137 d0beAcrobatv30.l $161.13 30days  yes US.

for Win 3.1/Win 95/NT

Adobe Acrobat v3.0.1
Cross Platform 10 PK
Infodata 132-33 Adobe 42001144 for Mac/PowerMac/Win 3.1/ $871.20 30 days yes U.s.

Win 95/NT

Adobe Pagemill v2.0.1
for Mac/PowerMac

Adobe Pagemill v3.0
for Win 95/NT 4.0

Adobe Acrobat v3.0.1
Infodata 132-33 Adobe 32001139 for UNIX - SUN/HP/AIX $128.91 30 days yes uU.s.

Adobe Acrobat v3.0.1
Infodata 132-33 Adobe 32001147 UNIX 10 Pack - SUN/HP/AIX $696.96 30 days yes uUs.

Adobe Type Basics v4.0
for Macintosh

Adobe Type Basics v4.0
for Windows

Adobe Type Manager Deluxe
Infodata 132-33 Adobe 01333164 V4.0 $54.59  30days yes  US.
for Mac/PowerMac

Adobe Type Manager Deluxe
Infodata 132-33 Adobe 02332019 V4.0 $54.59  30days yes U.S.
for Windows 95 only

Adobe Type Manager Deluxe
Infodata 132-33 Adobe 02332032 V4.0 $54.59  30days yes US.
for Windows NT only

Adobe Type Manager Deluxe 4.0
Infodata 132-33 Adobe 0133179 and Adobe Type Reunion Deluxe $65.54 30 days yes U.S.
v2.0

Infodata 132-33 Adobe 17700075 $81.38 30 days yes Us.

Infodata 132-33 Adobe 27700095 $81.38 30 days yes uUs.

Infodata 132-33 Adobe 17170000 $108.15  30days yes uUs.

Infodata 132-33 Adobe 27170000 $108.15  30days yes U.s.
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Adobe Type On Call v4.2
Infodata 132-33 Adobe 47040000  (Font Families 1-380) $37.69 30 days yes Us.
for Mac/PowerMac

Adobe Type Reunion Deluxe
v2.0

Infodata 132-33 Adobe 01871013 $32.77 30 days yes U.s.

for Mac/PowerMac
Adobe Font Folio v8.0 2

Infodata 132-33 Adobe 47060000 Printer/20 CPU License $4,478.91 30days yes u.s.

d R

Infodata 132-33 Adobe 18101020 “d0bePhotoDeluxev2.0 $2676  30days  yes US.
for Macintosh
Adobe PhotoDeluxe v2.0

Infodata 132-33 Adobe 28101021 for Win 3.1/Win 95/NT $26.76 30 days yes UsS.
Adobe Home Publisher

Infodata 132-33 Adobe 01481012 Dix CD 2.1for Macintosh $40.96 30 days yes U.S.
Adobe PhotoDeluxe

Infodata 132-33 Adobe 28110001 Business Edition v1.0 $54.07 30 days yes U.Ss.

Infodata 13233 Adobe 670001  ‘:dobeTypeTwister v1.0 $2730  30days  yes US.
for Macintosh

Infodata 132-33 Adobe 680001  “dobeType Twister v1.0 $2730  30days yes US.
for Windows

d i R

Infodata 132-33 Adobe 15500035 dobe Premierev3.0 $108.70 30days  yes US.
for PowerMac
Adobe Premiere v5.0 ‘

Infodata 132-33 Adobe 25500035 for Win 95/NT 4.0 or later $108.70  30days yes U.s.
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